
RealAudio and RealVideo

Content Creation
Guide
Version 5.0

RealNetworks, Inc.



Information in this document is subject to change without notice. Companies, names, and
data used in examples herein are fictitious unless otherwise noted. No part of this document
may be reproduced or transmitted in any form or by any means, electronic or mechanical, for
any purpose, without the express written permission of RealNetworks, Inc.

 1995-1997 RealNetworks, Inc. All rights reserved.

RealAudio and RealAudio logo are registered trademarks of RealNetworks, Inc.
RealVideo and the Real logo are trademarks of RealNetworks, Inc.
PowerPC is a trademark of IBM Corporation.
Adobe Premiere is a trademark of Adobe Systems, Inc.
Apple and Macintosh are trademarks of Apple Computer, Inc.
DolbyNet is a trademark of Dolby Laboratories, Inc.
Dolby Digital AC-3 audio system manufactured under license from Dolby Laboratories
Licensing Corporation.
Macromedia is a registered trademark and Shockwave is a trademark of Macromedia, Inc.
Netscape Netsite is a trademark of Netscape Communications Corp.
O’Reilly Website NT is a trademark of O’Reilly Associates, Inc.
Sonic Foundry and Sound Forge are trademarks of Sonic Foundry, Inc.
SunOS and Solaris are trademarks of Sun Microsystems, Inc.
UNIX is a registered trade mark of X/Open Company Limited.
Windows and Windows NT are trademarks of Microsoft Corp.
SE100 is a trademark of Creative Labs
Wakeboard Multimedia Pro is a trademark of Digital Video Arts
CD30 is a trademark of Miro
Bravado 1000 is a trademark of Truevision
Osprey 100 and Osprey 1000 are trademarks of Multimedia Access
Seagate AV drives is a trademark of Seagate
Sipro is a trademark of Sipro Lab Telecom, Inc.

RealNetworks, Inc.
1111 Third Avenue, Suite 2900

Seattle, WA 98101 USA
www.real.com

Printed in the United States of America. 



iii

Contents

Introduction ......................................................................................................................... 5
Streaming and Real-Time Delivery................................................................................... 5
Performance Range .......................................................................................................... 5
Content Sources ............................................................................................................... 6
Web Page Creation and Publishing................................................................................... 6
Using this Guide .............................................................................................................. 7

Overview ............................................................................................................................. 9
RealAudio and RealVideo Clips ....................................................................................... 9
Components of a RealAudio and RealVideo System ......................................................... 9
RealAudio and RealVideo Files and Metafiles ................................................................ 11
Delivering Synchronized Multimedia ............................................................................. 14
Static Encoding .............................................................................................................. 15
Modifying RealAudio and RealVideo Clips .................................................................... 15
Live Encoding and Live Broadcasting ............................................................................ 16
Title, Author, and Copyright .......................................................................................... 16

Installing RealEncoder and RealPublisher on Windows Platform....................................... 17

System Requirements......................................................................................................... 21
Windows 95 and Windows NT System Requirements..................................................... 22
Macintosh Requirements ................................................................................................ 26

Using RealEncoder and RealPublisher ............................................................................... 27
Bandwidth...................................................................................................................... 28
Encoding Templates....................................................................................................... 28
Source Files for Static Encoding..................................................................................... 28
Using Templates ............................................................................................................ 39
RealEncoder Plug-in for Adobe Premiere ....................................................................... 44
Encoding RealAudio or RealVideo Files......................................................................... 45
Creating Templates ........................................................................................................ 50

Synchronized Multimedia .................................................................................................. 55
Creating a RealVideo Events File ................................................................................... 55
Using Synchronized Multimedia with Bandwidth Negotiation........................................ 58
Frames: The Basics ........................................................................................................ 58

Editing Video Files ............................................................................................................ 59
Editing Input Files ......................................................................................................... 59



RealAudio and RealVideo Content Creation Guide

iv

Editing RealVideo Files in Windows .............................................................................. 59
Command Line Editing of RealVideo Files..................................................................... 64
Image Maps ................................................................................................................... 73
Modifying RealVideo File Descriptions .......................................................................... 77

Bandwidth Negotiation ...................................................................................................... 78
Creating Files with the Bandwidth Negotiation Option................................................... 78
Bandwidth File Organization ......................................................................................... 79
Bandwidth Negotiation Example .................................................................................... 89

Publishing Your Pages to the Web ..................................................................................... 91
Creating Web Pages (HTML) ......................................................................................... 91
Automatic creation of metafiles ...................................................................................... 93
Publishing your files....................................................................................................... 93

Live Broadcasting .............................................................................................................. 98
Advertising Your Event.................................................................................................. 99

Delivering Live Content....................................................................................................101
Setting Up RealServer ...................................................................................................101
EncoderPassword ..........................................................................................................102
EncoderTimeout............................................................................................................103
RealAudio and RealVideo Live Broadcasts....................................................................104

Simulating a Live Broadcast .............................................................................................112
Simulated Live Broadcast ..............................................................................................112

Configuring Your Web Site ..............................................................................................113
Making the Most of Your Content .................................................................................113
Metafiles .......................................................................................................................114
HTTP Streaming ...........................................................................................................117
Custom Controls for RealAudio and RealVideo .............................................................119

Synchronized Multimedia .................................................................................................136
Creating a RealVideo Events File ..................................................................................136
Creating a RealAudio Events File..................................................................................138
Using Synchronized Multimedia with Bandwidth Negotiation.......................................141
Frames: The Basics .......................................................................................................141

RealAudio and RealVideo Content Creation for Internet Appliances and Set-top Boxes ....143

Index ................................................................................................................................145



Introduction

5

Introduction

Real System is today’s most powerful solution for streaming real-time live and
on-demand audio and video over the Internet and corporate intranets. This
guide explains how to create and manage content for a RealAudio and
RealVideo System using either RealEncoder or RealPublisher.

Streaming and Real-Time Delivery

RealSystem enables streaming audio and video for reliable transmission under
real-life conditions. Streaming is the latest technology for audio and video
available and allows the audio or video clip to play as soon as it starts being
received by your computer. Real-time delivery means that you do not have to
wait while a file downloads; the clip plays as soon as your computer starts to
receive it. You also have complete control over the clip; you can pause, move
forward and back, and start or stop at any time.

Performance Range

With RealEncoder and RealPublisher  you can choose to deliver a range of
performance through ordinary modem connections all the way to corporate
Intranet LANs. You can also maximize the available bandwidth to meet the
demands of the content, for example, a music video requires different emphasis
than a simple speech.

RealAudio and RealVideo formats are optimized for low-to-high speed
connections including 14.4 and 28.8 Kbps modems, ISDN, T1 and LAN. You
can also listen or view RealAudio and RealVideo files stored locally on your
computer.
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Content Sources

You can acquire content from a variety of sources:

• pre-existing audio and video files, for example, .wav for audio and .avi and
.mov for video

• pre-recorded or live content from audio and video devices, such as
cameras, microphones, audiotape, videotape, or satellite feeds.

RealEncoder and RealPublisher create on-demand content that users can access
whenever they choose and can be created in all screen sizes. It can be played
from standard web servers or from RealServer streaming media servers for
higher reliability. Live audio and video require a RealServer streaming media
server.

Web Page Creation and Publishing

In addition to the features found in RealEncoder, RealPublisher offers new web
publishing features:

• automatic HTML page creation

• easy uploading of HTML pages to your web server with the click of a few
buttons

Web page creation and publishing can be accomplished using the step-by-step
wizards included in Real Publisher. RealPublisher also provides options for
display of your RealAudio or RealVideo clip on your web page.
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Using this Guide

ReaAudio and RealVideo Content Creation Guide is intended for people who
are familiar with operating World Wide Web servers and with RealNetworks
technology. You do not need previous experience using RealEncoder or
RealPublisher , but you do need to know how to create directories or folders,
copy files, and open text files.

Organization
This manual is organized in two sections:

Section 1: Overview

Explains the components and features of a RealAudio and RealVideo System.
Diagrams show the relationships between client and server for video and
multimedia delivery.

Section 2: Content Creation

Explains how to create and manage video and multimedia content for delivery
by RealServer and a Web server. The chapters are:

Installing RealEncoder/RealPublisher : Explains how to install
RealEncoder/RealPublisher .

Using RealAudio and RealVideo Files: Information about how to prepare files
for encoding, which encoding  setting to use and how to encode static and live
files using RealEncoder, RealPublisher or Adobe Premiere.

Delivering Live Content: Explains how to deliver live video, including setting up
RealServer streaming media server and advertising your event on the Timecase Web
site.

Synchronized Multimedia: Discusses how to create a synchronized
multimedia presentation.

Editing RealAudio and RealVideo Files: Explains how to use editing tools to
change the static information in a file, alter the data, and examine the contents
of a file.
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Publishing Your Files to the Web: Discusses how to generate HTML pages
and publish your web page and RealAudio and RealVideo files to a standard
HTTP Web server or a RealServer.

Managing Content on RealServer: Detailed instructions and examples of how
to use bandwidth negotiation.

Configuring Your Web Site: Explains the many ways you can deliver
RealAudio and RealVideo clips from your web site, including HTTP streaming,
Netscape Plug-in, ActiveX object, and JavaScript.

Conventions

This manual uses the following conventions:

Command Monospace font represents commands to be typed or
information displayed on the screen.

<file name> Angle brackets show where to insert information, such
as the name and location of a file.

[    ] Square brackets show optional command arguments.

Bold Bold font is used for names of files, directories,
commands, and options.
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Overview

Before you create and manage content for a RealAudio and RealVideo System,
you should understand how the system works. This chapter describes the basic
features and primary components of RealAudio and RealVideo System and
explains how they work together.

RealAudio and RealVideo Clips

A RealAudio or RealVideo clip is a file or live broadcast containing sound and
video encoded in RealAudio and RealVideo formats. These formats are highly
compressed to deliver the best possible sound and video over a limited-
bandwidth connection. Your audio and video can be stored for later use,
broadcast live over a network, or simultaneously stored as a file for later use
while it’s being broadcast live.

Because there is no single best format for delivering audio and video,
RealAudio and RealVideo System provides numerous formats that are
optimized differently for different kinds of content. You can choose to provide a
clip in one or more formats based on the type of content and the available
bandwidth. For example, you would use a different format to deliver speech
over a 14.4 Kbps modem than you would to deliver a music video over an ISDN
connection.

Components of a RealAudio and RealVideo
System

RealAudio and RealVideo use a client-server system. The server provides the
content to the client over a network. The basic components of a RealAudio and
RealVideo System are:
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RealPlayer - The client program that enables users to see and listen to
RealAudio and RealVideo clips. Special purpose player components enable
ActiveX and Netscape Plug-in capabilities.

RealEncoder/RealPublisher - The program that creates RealAudio and
RealVideo clips. The input to this program can be a digitized audio clip, a live
audio signal, a digitized video clip or a live video signal.

RealMedia Tools - The tools programs that can be used to modify RealAudio
and Video clips, including RMTools, RMMerge, RMCut, RMEdit, RMPaste
and RM Dump.

RealServer - The server program that delivers RealAudio and RealVideo clips
over a network. One RealServerstreaming media streamer can deliver clips to
many Players at the same time.

Web Browser - The client program that enables users to find most RealAudio
and RealVideo clips. The Web browser is also used to display the visual part of
Synchronized Multimedia presentations. RealAudio and RealVideo System
works with all popular Web browsers.

Web Server - The server program that delivers Web pages. Typically,
RealAudio and RealVideo clips are accessed by clicking a link on a Web page.
The Web server also delivers the visual part of Synchronized Multimedia
presentations. HTTP streaming of RealAudio or RealVideo files enables content
providers to stream RealAudio and RealVideo clips from a World Wide Web
server. While this method is not as robust, it provides a reasonable method for
providing short RealAudio and RealVideo content to a limited number of users.
RealAudio and RealVideo works with all popular Web servers.
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RealAudio and RealVideo Files and
Metafiles

RealAudio and RealVideo System uses several file types, each identified by a
specific file extension. The files and their file extensions are:

RealAudio (.ra) clip - Audio encoded clip. This file is created with the
RealAudio Encoder.

RealMedia clip (.rm) - Audio or video encoded to RealAudio and RealVideo
formats. Files created with RealEncoder or RealPublisher and delivered by the
RealServer can contain multiple streams, including audio, video, image maps,
and events. Video files can contain audio and video or video only and can be
played with RealPlayer .. Audio only files can be played by RealPlayer.

RealMedia metafile (.ram) -. The metafile contains the URL of one or more
RealAudio (.ra) and RealVideo (.rm) files located on a RealServer streaming
media server. The file that is used as an alias or pointer on a Web page to one
or more RealAudio or RealVideo clips. The metafile is typically located on a
Web server and is linked on a Web page.

RealPlayer Plug-in metafile (.rpm) - The same as a metafile, but used with
RealPlayer Plug-in for Netscape Navigator and Internet Explorer 3.0 and
later.RealAudio Event (.rae) The event file is used in synchronized multimedia.
It is created with one of several  event compiler utilities which comes bundled
with the RealAudio and RealVideo Encoders.

Windows
 The 3.0 Encoder events compiler is “Cevent32.exe.”  The 4.0 and 5.0 RealVideo

Encoder’s compiler is built into the Rmmerge utility.

Macintosh
The 3.0 RealAudio Static Encoder Events Compiler is “Ra Event Compiler.”
The 4.0 and 5.0 RealVideo Encoder
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Delivering a RealAudio or RealVideo Clip

The following figure shows the components of RealAudio and RealAudio and
RealVideo System used to deliver a typical RealAudio or RealVideo clip. The
numbers in the figure match the numbered steps following the figure.
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1. The Web browser displays a Web page that contains a link to a metafile.

2. The user clicks the link. The Web browser requests the metafile from the
Web Server.

3. The Web server delivers a metafile to the Web browser.

4. The Web browser looks up the MIME type of metafile. Based on the
MIME type, the Web browser starts RealPlayer as a helper application and
passes it the metafile.

5. RealPlayer reads the first URL from the metafile and requests it from
RealServer streaming media server.

6. RealServer begins streaming the requested RealAudio or RealVideo clip to
RealPlayer.

Note: No messages pass between the RealServer and the Web server. The Web
browser provides the URL of RealAudio or RealVideo clip to RealPlayer.
RealPlayer does not require a Web browser to function; users can enter the URL
of a .ra, .rm or .ram file directly into RealPlayer, or use the Preset or Scan
buttons on RealPlayer Plus.
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Delivering Synchronized Multimedia

Synchronized Multimedia delivery works like regular RealAudio or RealVideo
delivery, with one extra step between RealPlayer and the Web browser.

The following figure shows the components of RealAudio and RealVideo
System used to deliver a typical RealVideo Synchronized Multimedia
presentation. The numbers in the figure match the numbered steps following
the figure.

Web
Server

               linked
                   .ram

        file

Real
  Server

Web
Browser

RealPlayer

ServerClient

3

6

5

6

8

2

1

3

1

7

4

7

Media Delivery System

1. The Web browser displays a Web page that contains a link to a metafile.

2. The user clicks on the link. The Web browser requests the metafile from
the Web Server.
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3. The Web server delivers a metafile to the Web browser.

4. The Web browser looks up the MIME type of metafile. Based on the
MIME type, the Web browser starts RealPlayer as a helper application and
passes it the metafile.

5. RealPlayer reads the first URL from the metafile and requests it from
RealServer.

6. RealServer begins streaming the requested RealAudio or RealVideo clip to
RealPlayer.

7. RealServer concurrently notifies RealPlayer via an event file (.rae) when an
event should occur. For more information see the chapter on
“Synchronized Multimedia”.

8. RealPlayer sends the URL for the event to the default Web browser for
viewing.

Static Encoding

RealAudio and RealVideo clips may be created from previously captured digital
audio or video files. With static encoding, these files are compressed and are
converted to RealAudio and RealVideo formats.

Modifying RealAudio and RealVideo Clips

When you encode a RealAudio or RealVideo clip, both RealEncoder and
RealPublisher create a new file with a .rm file extension. The original file is not
modified. Encoding a RealAudio or RealVideo clip is a one-way process; you
cannot convert a RealAudio and RealVideo file back into the original source
format. If you want to be able to encode other formats in the future, you need to
archive the original source.
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It is possible to modify some attributes of RealAudio and RealVideo clips
without re-encoding them, such as Title, Author and Copyright  and enabling
or disabling PerfectPlay and Selective Record

Live Encoding and Live Broadcasting

The source of a RealAudio or RealVideo clip can also be live input. The
encoded RealAudio or RealVideo clip can be broadcast live over a network,
stored as a file for later use, or it can be simultaneously stored as a file, or
archived, and broadcast live.

RealEncoder and RealPublisher for Windows can encode a live input source.
RealEncoder for the Macintosh cannot encode a live input source, and
RealPublisher does not support Macintosh.

Live broadcasting requires a license and a RealServer streaming media server.

Title, Author, and Copyright

RealAudio and RealVideo clips include text strings for the title, author, and
copyright. This text is displayed by RealPlayer when the clip is played.
Although the player usually labels the text as title, author, and copyright, the
player displays whatever text you choose to supply.

You enter the title, author, and copyright text when encoding a clip. You can
change this text after encoding by using the metafile. For information on
metafiles, refer to the “Configuring Your Web Site” chapter. You can also
change the text by using RMEdit and RMTools.
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Installing RealEncoder and
RealPublisher on Windows
Platform

Installing RealEncoder and RealPublisher is quick and easy. You can download
the RealEncoder or RealPublisher from the RealNetworks Web site or install it
from the RealServerCD-ROM. The installation procedure below is for the
Windows platform.

To download the install program from the Intenet:

1. With a Web browser, download the installer from the RealNetworks Web
site:

                    http://www.real.com

2. Go to audio and video encoder download pages.

3. When prompted, click the Save to Disk button and specify the temporary
directory for the installation program. Note where you saved it.

4. In File Manager or Explorer, double-click the icon to activate the
automated installation process.

To install RealEncoder setup program from CD-ROM:

1. Insert the CD-ROM into the drive

2. In File Manager or Explorer, double-click instenc50.exe in the
\video\encoder\intele-nt  directory of the RealServerCD-ROM to activate
the automated installation process.

To install RealPublisher setup program from CD-ROM:

1. Insert the CD-ROM into the drive
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2. In File Manager or Explorer, double-click on instenc50.exeor
instpub50.exe in the \video\encoder\intele-nt directory of the
RealServerCD-ROM to activate the automated installation process.

To complete the installation of RealEncoder or RealPublisher:

1. Close any other applications that may be open and click the Next button.

2. To accept the terms and conditions for installing RealEncoder or
RealPublisher, click the Next button.

3. Enter your name, company or organization name, and e-mail address.
Then click the Next button.

4. To install the encoder into the default directory, click Next. If you wish to
install the encoder in a different location, click Browse and select the
directory into which you want to it.

5. If you are installing over an existing RealVideo or RealAudio Encoder for
which you have defined custom styles (templates), select Keep Existing
Templates if you want to preserve the custom styles.

6. To finish the installation, click Finish.

7. Click OK.



Installing RealEncoder and RealPublisher on Windows

19

The following files are installed in the RealEncoder/RealPublisher
directory (\Real\RVEncode by default):

File Description

enclic An ASCII text file that contains the license
agreement for the encoder.

EX-RM.prm Adobe Premiere plug-in.

graphic.gif Real logo.

pninet.dll A dynamic link library used for Internet functions.

pntouch.dll A dynamic link library used for registration.

pnwebpub.dll A dynamic link library used for web publishing.

Readme.htm Information about Encoder installation and
operation.

rmcut.exe A utility that returns a copy of the stream from start
to endtime without modifying the original source.

rmdump.exe A utility used to examine the contents of a
RealAudio or RealVideo file.

rmedit.exe A utility used to modify the title, author, copyright,
comment, mime type, or stream name of a
RealAudio or RealVideo file.

rmevents.dll A dynamic link library used by the rmmerge utility.

rmimap.dll A dynamic link library used by the rmmerge utility.

rmmerge.exe A utility used to create a Synchronized Multimedia
presentation.

rmpaste.exe A utility used to re-sort from bandwidth to
timestamp order.
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File Description

RMTools.exe GUI for showing stream number and name, mime
type, start and endtime of source and destination
files.

rvbatch.exe Lets you run the encoder from a batch file as a
command-line tool.

rvencode.exe The RealEncoder/RealPublisher executable.

rvslta Simulated Live Transfer Agent.
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System Requirements

This section outlines the basic hardware and software requirements to create
RealAudio and RealVideo content. It contains information about the technical
specifications for static encoding, used for creating on-demand content and
about live encoding which enables real-time live broadcasting.

Real Encoder and RealPublisher compresses high-bandwidth video signals to a
low-bandwidth signal. This compression allows for the real-time transmission
of clips via the Internet, even over a connection as slow as a 14.4 Kbps modem.

RealAudio content consists of audio only while RealVideo content can consist
of audio and video or video only.

RealEncoder is available for:

• Windows 95 and Windows NT (static and live content)

• Macintosh (static content)

RealPublisher is available for:

• Windows 95 and Windows NT (static and live content)
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Windows 95 and Windows NT System
Requirements

Static and Live Encoding RealAudio for Windows 95/NT
Different hardware is required for encoding an audio file and encoding a live
audio stream.

Requirement Minimum Recommended

CPU 486/66 DX Pentium 586, 75MHz

RAM 8 MB 8 MB required, 16
MB recommended

Hard Disk space (software) 1 MB 1 MB

Sound Card Depends on audio codec chosen. See table
on p.38 for sampling rates required.
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Static Encoding RealVideo for Windows 95/NT

Requirement Minimum Recommended

CPU 486/66 DX Pentium 120

RAM 16 MB 64 MB

Hard Disk space (software) 4MB 4 MB

Hard Disk space (data) 500 MB 1 GB

Color Display 16-bit 24 bit (TrueColor)

Video Capture Card Any quality card

Sound Card 16-bit sound card

*Video and sound cards are needed only for capture-to-file encoding and are
not necessary for encoding of pre-existing AVI or QuickTime files. See more
information in the “Live Capture-to-File” section of the “Using RealEncoder
and RealPublisher” chapter.
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 Live Encoding RealVideo for Windows 95/NT

High quality live encoding takes longer and requires greater computing
resources than lower quality.  Here are the requirements for encoding at low
and high frame rates. Slower machines also give reasonable results in Slide
Show mode at 1fps or less.

Requirement Low Frame Rate
(less than 2 fps)

High Frame Rate
(more than 2 fps)

OS Windows 95 Windows NT

CPU Pentium 166 MHz Dual Pentium 200 MHz

RAM 32 MB 64 MB

Hard Drive 1 GB 1 GB

Color Display 16-bit 24-bit (TrueColor)

Video
Capture Card

Any native VFW-capable
capture card

Osprey 100, Osprey 1000

Sound card Any quality audio card

Capturing video puts a burden on your computer’s ability to write to your hard
drive. Seagate manufactures special hard drives for capturing video called AV
drives. If you do not use one of these special drives, frames may be dropped
during the capture process when the hard drive re-calibrates itself periodically.
If you experience dropped frames with a standard drive, you can re-capture the
video.
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The following lists the recommended settings for a variety of different live
content types:

Content
Type

Total Bit
rate

Audio
codec

Frames/
sec

Quality
Setting

General 20 Kbps 6.5 Kbps 2 100

General 20 Kbps 6.5 Kbps 7.5 70

Newscast 20 Kbps 6.5 Kbps 4 100

Newscast 45 Kbps 8.5 Kbps 10 1

Music 20 Kbps 12 Kbps 5 100

Music 45 Kbps 16 Kbps 5 70

Note:  If you are not getting the desired frame rate, lower the quality setting.
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Macintosh Requirements

For Macintosh users, RealEncoder supports only static encoding for video and
audio. It does not support live video or audio encoding. 68K Macintosh
computers are also not supported. RealPublisher is not available for Macintosh
users.

Static Encoding RealAudio and RealVideo for the Macintosh

Requirement Minimum Recommended

CPU Any Power PC 604 Power PC

RAM 16 MB 32 MB

Hard Disk space (software) 4 MB 4 MB

Hard Disk space (data) 500 MB 1 GB

Operating System 7.5.5 8.0

Note:  RAM requirements may be slightly less for RealAudio.
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Using RealEncoder and
RealPublisher

This chapter details RealEncoder and RealPublisher operations, including
supported input formats, output options, and how to achieve the best possible
audio and video quality.

RealEncoder allows two types of encoding:

• static encoding for pre-existing audio and video files
 (Windows and Macintosh)

• live encoding, for live broadcasting and archival purposes
(Windows only)

RealPublisher allows two types of encoding:

• static encoding for pre-existing audio and video files
 (Windows only)

• live encoding, for live broadcasting and archival purposes
(Windows only)

RealEncoder and RealPublisher enable you to compress video files or input
from a video device into one or more RealAudio or RealVideo formats. Output
can be sent to a file or directly to a RealServer streaming media server for live
broadcasting.

You can select input files by browsing from within RealEncoder or
RealPublisher, or you can drag-and-drop files for automated processing. The
Encoder window displays information about input and output file formats and
has fields for entering descriptive information.  You can specify options such as
the compression type and copyright string to be included in the output file.

Some video editing programs can encode and write files in RealVideo format.
For example, a RealEncoder Plug-in is available for Adobe Premiere.
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There is a difference between encoding from a live source and broadcasting a
live event.  Broadcasting from a live source requires a special license purchased
with your RealServer streaming media server. For information about serving a
live stream refer to the chapter on “Delivering Live Content”.

Bandwidth

Bandwidth, also known as bit-rate, is the amount of data that can be received
by your modem during a set period of time. Bandwidth is measured in kilobits
per second (Kbps). Standard modems are commonly referred to by the bit-rate
they are able to receive, for example, 14.4, 28.8, and 56K. These designations
may already be familiar to you.

In addition to standard bandwidths, you can encode clips for bit-rates up to 500
Kbps. These higher bandwidths, however, are generally more typical of
corporate intranets or entertainment-based web sites.

Encoding Templates

You can select a pre-defined encoding template or design a template
specifically for the type of audio or video you are encoding. An encoding
template allows you to specify bandwidth options for your content, whether for
audio only, video only, or audio and video.

RealEncoder and RealPublisher come with pre-defined templates that enable
you to encode your content specifically for your target audience.

Source Files for Static Encoding

RealAudio and RealVideo clips may be created from previously captured digital
audio or video files.
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Video Formats supported by RealEncoder:

For Windows:

• Video for Windows (.avi).  RealEncoder accepts compressed or
uncompressed formats, although it is recommended you use uncompressed
formats whenever possible.

• QuickTime for Windows (.mov)  Only uncompressed files are supported.

For Macintosh:

• Quicktime for Macintosh (.mov). Uncompressed files and some
uncompressed files are supported.  Compressed files supported are Cinepak
files and Apple’s Video Compressor. It is recommended, however, you use
uncompressed formats whenever possible.

Audio Formats supported by RealEncoder:

It is recommended that you use uncompressed files whenever possible.

For Windows:

• Waveform (.wav). RealEncoder accept compressed or uncompressed
formats, although it is recommended you use uncompressed files.

• QuickTime for Windows (.mov)

• Audio (.au)

• Sound (.snd)

 For Macintosh:

• Audio Interchange File (.aif)

• Waveform (.wav)

• QuickTime for Macintosh (.mov)

• Audio (.au)
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• Sound (.snd)

Video  formats supported for RealPublisher:

• Video for Windows (.avi).  RealPublisher accepts compressed or
uncompressed formats, although it is recommended you use uncompressed
formats whenever possible.

• QuickTime for Windows (.mov).

The following audio formats are supported by RealPublisher. It is
recommended that you use uncompressed files whenever possible:

Audio formats supported for RealPublisher:

• Waveform (.wav). RealPublisher accepts compressed or uncompressed
formats, although it is recommended you use uncompressed files.

• QuickTime for Windows (.mov)

• Audio (.au)

• Sound (.snd)

AVI Requirements:

• AVI files should have a color depth of 24-bits.

• The standard video frame size for the Internet is 176 x 144, however
height and width must both be divisible by 16. Height and width can also
be 160 x 120.

• File should be uncompressed for best results.

• Indeo drivers must be installed on your machine for the encoder to be able
to open .avi files created with the YUV9 format. The Indeo drivers are
available from the Intel web site at www.indeo.com. However, if you
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captured an AVI on the same machine as RealEncoder and RealPublisher,
the encoder typically has no problem opening it.

To determine if you have the AVI video codec for a particular AVI file:

1. Right-click the file name.

2. Click Properties.

3. Click Details tab. Look at the Video Format field.

 If the Video Format field says "Unknown format" most likely the
corresponding AVI video codec is not installed.

4. If the Video Format field lists a format, click Preview tab. You should be
able to view the video in the preview window.

If you can preview the video, and still receive an error when encoding the
AVI file, the file may not be in 24-bit color. You can convert the file to 24-
bit file using a third-party video editing tool.

QuickTime requirements:

• 24-bit RGB QuickTime video files

• 8- 16-bit mono and stereo audio

• On Windows platforms for RealEncoder and RealPublisher, files must
be uncompressed.

• On Macintosh platforms for RealEncoder only, files can be
uncompressed or compressed (Cinepak, Apple’s Video Compressor, or
Raw), but it is recommended you use compressed files whenever
possible.
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Image Size

RealEncoder and RealPublisher support any size image that is divisible by 16.
The most common size is 176 x 144 pixels or 320 x 240 pixels. An image size
of 160 x 120 is also supported.

Image cropping

1. To encode only part of the screen, select Crop Enabled from the Options
menu. To edit the image cropping settings, select Crop Settings from the
Options menu.  The Image Cropping window displays. Notice the crop
lines around the image. These lines show the portion of the image that will
be encoded. Use Left, Top, Width, and Height to adjust the size and
location of crop lines.

2. If you need to edit the crop settings, select Crop Settings from the Options
menu.

3. Click the Start button to start the encoding process. When file encoding is
complete, an Encoding Complete message appears indicating the bit rate
the file was encoded at.

 If RealPublisher is unable to encode the file of the selected bit rate, you
need to re-encode the file with a different template.

4. View the encoded file with RealPlayer.

Volume Control

1. Select Volume Control from the Options menu.  The Volume Control
window displays.

2. Select Properties from the Options menu.  The Properties window
displays.

3. Click Recording to adjust the input recording volume. (Playback adjusts
the level of the volume you hear while you are encoding, not the volume
the end-user hears.)
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4. Select from the list of volume controls the type of inputs you will be using
and click OK.  The Volume Control window will display the volume
controls you select.

5. Select which recording inputs to use by clicking and checking the Select
box for each input.

6. Adjust the sound level by moving the sliders up or down. Remember, if the
volume is too high, the encoded sound may be clipped and appear
distorted.  If the volume is too low, it will be difficult to hear. Use the audio
level meter in the RealEncoder window to monitor the level during
encoding.

7. Close the Recording Control window and return to the RealPublisher or
RealEncoder.

 Follow previous steps 10-16 only if the audio meter in the RealEncoder or
RealPublisher window indicates the input signal is too low.

8. Close the Recording Control window.

Using the audio level meter

While you encode RealAudio or RealVideo you can monitor the audio input
level to be sure you are encoding the optimal dynamic range. Green indicates a
normal reading. Red warns that you are close to an over-modulated input. The
best sound quality will occur when the top red bar is often lit but the clipping
indicator never goes off.

Producing High Quality Video

To create the best possible streaming audio and video, you must start with the
best possible source material. Different video formats yield different qualities
when captured or “digitized.” Because RealAudio and RealVideo compression
algorithms are lossy, some of the information contained in your original input
is not included in the reconstructed signal sent to RealPlayer.



RealAudio and RealVideo Content Creation Guide

34

In particular, different video formats yield different qualities when digitized.
Additionally, video playback devices commonly have two types of video
outputs, S-video and composite.  S-video produces better results.

The common video formats in order of quality are:

1. Betacam-sp, also known simply as Beta. This format is common among
video production professionals.

2. Laserdisc

3. S-VHS or Super-VHS

4. VHS

Satellite television services (e.g. Direct TV) have extremely high quality video.
Their feed quality typically exceeds that of Laserdisc.

Live Capture-to-File

If you have a real-time capture station, you can use it to capture and compress
directly into RealAudio and RealVideo formats. To do this, use the output of a
video player and set the encoder to capture-to-file instead of capture-to-a-live-
server feed. This has the advantage of eliminating the need to create and store
intermediate AVI files which are very large and take considerable disk space. It
is also the fastest way to capture content like breaking news clips when time-to-
post is important.

Editing

Limited video editing tools are available with RealEncoder and RealPublisher.
You can edit files using the RMTools utility. Operations include stream cutting,
copying, and pasting. You can also edit Title, Author, and Copyright
information. For more information, refer to the chapter on  “Editing Video
Files”. For more advanced editing features the following programs are
recommended:

• Adobe Premiere
• In:sync Kohesion
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RealEncoder and RealPublisher install an Adobe Premiere plug-in, allowing
you to encode directly from Premiere.

Encoding with Adobe Premiere 4.2

To encode audio and video files in Adobe Premiere 4.2:

1. Start Adobe Premiere 4.2.

2. Click Open from the File menu.

3. Select one of the supported file types. The file appears in the Clip window.

4. Select the Clip window.

5. Click Export from the File menu and select RealEncoder. The
RealEncoder Options window appears (Windows version):

6. In the media options pane, select one of the pre-installed templates. These
templates are guidelines for creating content containing both audio and
video. You can save your own templates, or delete templates that you do
not use. If you delete a template you created yourself, it will be
permanently deleted. If you delete a template which was installed by
RealEncoder, you can get it back by reinstalling RealEncoder.

7. Once you have selected a template, you can change any of the audio
codecs, any of the video codec settings, or the total bit rate.

8. Click Optimized Frame Rate or Fixed Frame Rate.

 For all pre-defined tempaltes, the defualt setting is Optimized Frame Rate.

• You can select Optimized Frame Rate when using the RealVideo Standard
video codec. Optimized Frame Rate provides constant image clarity, or
sharpness, and variable frame rates. When this option is selected, the
encoder automatically selects the frame rate.

 For example, if a person who is talking begins to gesture or move around
quickly, the frame rate increases as the motion speeds up and decreases as
the motion slows down. The image sharpness remains constant throughout.
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• You can select Fixed Frame Rate when using the RealVideo Standard
video codec or the RealVideo Fractal video codec. Fixed Frame Rate is
adjusted by moving the slider. Fixed Frame Rate gives you the option of
choosing to emphasize image clarity or motion smoothness.

 For example, if your content contains a lot of motion, set the slider closer
to the 15fps setting. The resulting video image will be less clear but will
exhibit smoother motion, i.e., more frames per second.

 However, if your content has less motion, set the slider closer to the .050fps
setting. The resulting video images will be more clear but will exhibit less
smooth motion, i.e. fewer frames per second.

9. Click Save to save the template.

10. Click Close to close the Advanced Settings window.

11. Click Save to save the template.

12. Click Close to close the Advanced Settings window.

13. In the properties pane, enter the Title, Author, and Copyright information
for your output file. These fields are optional.

14. RealPlayer users with low bandwidth modems can experience files encoded
for a higher bandwidth by partially downloading audio and video data
before beginning playback. If you want to allow this, click Allow
PerfectPlay. This is the default setting.

15. If you want to allow RealPlayer Plus users to save your clip to disk, click
Allow Selective Record.

16. In the Marker Options frame, click the appropriate option. Refer to Marker
Options for more information.

17. In the destination pane, click Select and enter the name of the output file.

18. Click Encode. Adobe Premiere begins encoding the file.

19. When the file is encoded, a Status dialog box appears, providing details
about the encoded file. Click OK.

20. Play the encoded file using RealPlayer.
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Marker Options

Marker options allow you to take advantage of the Marker feature in Adobe
Premiere.

• Click Off to encode the entire clip regardless of markers. Choosing this
option means that you don’t have control over which frames get encoded.

• Click Key Frames to encode a marked file. Choosing this option will
ensure that all frames that are marked are encoded.

• Click Slide Show Frames to encode only the marked frames. Choosing
this option allows you to create slide shows out of video files and gives you
control over exactly which frames you want to use.

To set and clear numbered and unnumbered markers, first activate the “clip”

• You can add unnumbered markers by pressing  "+" or "=" while in the clip
window.

• You can remove any marker by pressing "c" or "v".

Note:   The plug-in recognizes both Premiere’s numbered (up to 10 available)
and unnumbered markers (up to 1000 available).

Producing High Quality Audio

• Use high quality source files or recording input device.

• If you are not doing a live broadcast, capture or “digitize” the sound to a
supported file format such as a  .wav, mov, or .aif whenever possible.

• Digitizing the sound before encoding the file allows you to use a sound
editor to adjust the amplitude of your signal to maximize the available
dynamic range.  If you do not adjust the signal, the resulting RealAudio
and RealVideo files may sound flat.

• If your original audio file signal exceeds the acceptable amplitude range,
the file may “clip.” Clipping can give rise to clicks or pops on playback. If
your source file contains a clipped signal, your final RealAudio or
RealVideo file will have high-frequency background noise or static.
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• Eliminate any DC offset either while recording or later with an audio
editor. This removes low frequency noise.

• When encoding live-source audio, you have less opportunity to manipulate
your input signal. Be sure that volume levels are prepared and tested.

• Cut any unnecessarily long silences from the beginning or end of the
output file to conserve space.

Encoding with Multiple Audio Codecs

Use a CD quality sampling rate (44.1 kHz), sampling width (16-bit) and two
channels when creating an input file that you intend to encode using multiple
audio codecs.

Synchronizing Audio with Video and Preventing Pitch Shifting

To ensure that the audio stays synchronized with video or other time critical
media and to prevent pitch shifting in audio resampling, the following sample
rates need to be used with the following codecs

Codec Sampling Rate

14.4 8, 16 or 32 kHz

5 Kbps voice 8, 16, 32 kHz

6.5 Kbps voice 8, 16 or 32 kHz

8.5 Kbps voice 8, 16 or 32 kHz

15.2 Kbps voice 8, 16 or 32 kHz

16 Kbps voice 16 or 32 kHz

8 Kbps music 8, 16 or 32 kHz

12 Kbps music 8, 16 or 32 kHz

16 Kbps music High response 11.025, 22.05 or 44.1 kHz

16 Kbps music Med response 11.025, 22.05 or 44.1 kHz

16 Kbps music Low response 8, 16 or 32 kHz

20 Kbps music stereo 8, 16 or 32 kHz
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Codec Sampling Rate

40 Kbps music mono 11.025*, 22.05 or 44.1 kHz

40 Kbps music stereo 8*, 16 or 32 kHz

80 Kbps music mono 11.025*, 22.05* or 44.1 kHz

80 Kbps music stereo 8*, 16* or 32 kHz

 *  The sample rates are lower than the default input rates of the encoder. For
fuller sound, it is recommended you use the higher sampling rates.

Using Templates

Before you begin encoding, you must make decisions about the appropriate
settings for different types of audio and video input. RealNetworks has supplied
several pre-defined encoding templates to assist users in making those decisions.
For a list of these templates, refer to the chapter “Using RealEncoder and
RealPublisher.”

You can adjust these templates or define a new one to optimize the type of audio
and video you are encoding. For information about creating templates, refer to
the “Using RealEncoder and RealPublisher” chapter.

Each template is optimized for a particular type of audio and video content as
well as for bandwidth. You can select one or more templates that best suit your
needs, and RealServer streaming media server can deliver clips encoded using
these multiple templates. In this way, you can reach the widest possible
audience while still providing high-bandwidth users with the best listening
experience.

Taking it a step further, by using Bandwidth Negotiation you can configure
your site to automatically serve the appropriately encoded file. For more
information about Bandwidth Negotiation, refer to the “Bandwidth
Negotiation” chapter .
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Pre-defined Templates

Each template is optimized for a particular type of audio and video content as
well as for bandwidth. Select a template that best suit your needs. RealEncoder
and RealPublisher also allow you to use more than one template.

 Notice that the total bit rate is a combination of the audio codec and the video
bit rate. The total bit rate for each template is about 30% less than the total bit
rate of the bandwidth of the connection to compensate for connection and
packet overhead.
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Template Name Audio
Codec

Video Bit
Rate
(Kbps)

Total
Bit Rate
(Kbps)

Encoding
Speed

Video
Frame
Rate

Audio 14.4,
Voice

8.5Kbps
Voice

0.0 8.5 Normal

Audio 28.8,
Music – Mono

16Kbps
Music -
High
Response

0.0 16 Normal

Audio 28.8,
Voice

16Kbps
Voice -
Wideband

0.0 16 Normal

Audio 28.8,
Music – Stereo

20Kbps
Music
Stereo

0.0 20 Normal

Video 28.8, High
Action

6.5Kbps
Voice

13.5 20 Normal Optimal
Smooth

Video 28.8,
Music Video –
Emphasize Audio

12Kbps
Music

8.0 20 Normal 0.25

Video 28.8,
Music Video –
Emphasize Video

6.5Kbps
Voice

13.5 20 Normal Optimal
Sharp

Video 28.8,
Talking Heads

5Kbps
Voice

13.5 20 Normal Optimal
sharp

Audio 56K Dial-
Up Modem,
Music - Mono

32Kbps
Music
Mono

0.0 32 Normal
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Template Name Audio
Codec

Video Bit
Rate
(Kbps)

Total
Bit Rate
(Kbps)

Encoding
Speed

Video
Frame
Rate

Audio 56K Dial-
Up Modem,
Music - Stereo

32Kbps
Music
Stereo

0.0 32 Normal

Video 56K Dial-
Up Modem,
Music

12Kbps
Music

22.0 34 Normal Optimal
Sharp

Video 56K Dial-
Up Modem,
Voice

6.5Kbps
Voice

27.5 34 Normal Optimal
Sharp

Audio 56K ISDN,
Music – Mono

40Kbps
Music
Mono

0.0 45 Normal -

Audio 56K ISDN,
Music – Stereo

40Kbps
Music
Stereo

0.0 45 Normal -

Video 56K ISDN,
Music

16Kbps
Music -
High
Response

29.0 45 Normal Optimal
Sharp

Video 56K ISDN,
Voice

8.5Kbps
Voice

36.5 45 Normal Optimal
Sharp

Audio High-Bite
Rate 80K, Music
- Mono

80Kbps
Music
Mono

0.0 80 Normal -

Audio High-Bite
Rate 80K, Music
- Stereo

80Kbps
Music
Stereo

0.0 80 Normal -
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Video High-Bite
Rate 100K,
Music

16Kbps
Music -
High
Response

84.0 100 Normal Optimal
Average

Video High-Bite
Rate 100K, Voice

16Kbps
Voice -
Wideband

84.0 100 Normal Optimal
Average

Video High-Bite
Rate 200K, Music

16Kbps
Music -
High
Response

160.0 200 Normal Optimal
Average

Video High-Bite
Rate 200K, Voice

16Kbps
Voice -
Wideband

184.0 200 Normal Optimal
Average

Video High-Bite
Rate 400K, Music

16Kbps
Music -
High
Response

360.0 400 Normal Optimal
Average

Video High-Bite
Rate 400K, Voice

16Kbps
Voice -
Wideband

384.0 400 Normal Optimal
Average

Multiple Templates

RealServer streaming media server can deliver clips encoded using multiple
templates. In this way, you can reach the widest possible audience while still
providing high-bandwidth users with the best viewing and listening experience.
If you are not using bandwidth negotiation to provide content in multiple
formats, your web site must have separate hypertext links and metafiles for
each format.
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RealEncoder Plug-in for Adobe Premiere

RealEncoder Plug-in for Adobe Premiere 4.2 exists for both Windows and
Macintosh platforms. Currently, the Windows version is installed by
RealEncoder and RealPublisher. The Windows Adobe Premiere plug-in is
installed in the /Premiere/plugins directory. The Macintosh Adobe Premiere
plug-in must be copied to the plug-in directory in the Premiere folder.

The Real Encoder Adobe Premiere plug-in does not work with Adobe Premiere
LE because Premiere LE does not support third party plug-ins.

Supported File Formats

RealEncoder Plug-in for Adobe Premiere supports all of the file types supported
by Adobe Premiere.

Supported Movie File formats are:

• Video for Windows (.avi)

• QuickTime for Windowsand Macintosh (.mov)

• FilmStrip (.flm)

Note:  It is strongly recommended you use uncompressed files only

Supported audio formats are:

• Audio Interchange (.aif)

• Windows Waveform (.wav)

Note:  Audio source files must be sampled at 11.025, 22.05, or 44.1 kHz.
8-bit and 16-bit mono and stereo audio files are supported.
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Encoding RealAudio or RealVideo Files

To create a RealAudio or RealVideo file from an existing audio or video file using
RealEncoder or RealPublisher for Windows:

1. Start RealPublisher or RealEncoder. The RealPublisher or RealEncoder
window opens:

2. Click Open Session from the File menu. The Open Session window appears.

3. In the source pane, verify that File is selected.

4. Click Add. The Add Source File dialog box appears.

5. Select the file you want to encode. Click Open.

6. In the destination pane, verify RealMedia File is checked.

7. Click Save As. The Select Destination File dialog box appears.

8. Choose a directory to store the file and enter the destination file name.

9. Click Save.

10. Click OK. The Open Session window closes.

11. In the properties pane, you can enter the Title, Author, and Copyright
information for your output file. These fields are optional.

12. Click PerfectPlay if you wish RealPlayers with low bandwidth modems to
be able to play RealVideo files encoded for a higher bandwidth. To play
these file, the files must partially download audio and video data before
beginning playback.

13. If you wish RealPlayer and RealPlayer Plus users to be able to save your
RealVideo or RealAudio signal to disk, click Selective Record.

14. In the encoding templates list box, select the template for the target
audience you want your file to play for.
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15. Click Start to begin the encoding process. When encoding is complete, an
Encoding Complete message appears indicating the bit rate the file was
encoded at.

 If RealPublisher is unable to encode the file at the selected bit rate, you
may need to re-encode the file with a different template. To edit your
template settings, click Advanced and re-encode your file with the updated
template.

16. View the encoded file with RealPlayer.

Drag-and-Drop Encoding for Windows

RealEncoder and RealPublisher for Windows support drag-and-drop encoding:

• Click an input-video-file icon and drag it onto an open Publisher or
Encoder window. This enters path and file name information into the
appropriate Encoder fields.

• Then, you only need to enter the descriptive information and settings and
click Start to begin the encoding process.

Multi-Template Encoding

You can encode more than one RealAudio or RealVideo file at the same time
using multi-template encoding. This allows you to encode your files with
different compression rates based on the bandwidth capability of the user.

Encoding a single file using multiple templates generates multiple output files
and can be used for testing or allow the user to choose to stream the best file for
the user’s bandwidth.  If used without bandwidth negotiation, your web site
must have a separate hypertext link and web page for each format or template.

Using bandwidth negotiation with multi-template encoding requires only one
link on your web site to a particular clip, regardless of the number of files and
enables the server to automatically stream the best file for the user’s stated
bandwidth.
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To encode a file with multiple templates:

1. Start RealPublisher from your desktop and follow steps 1-13 for encoding
audio and video files. Refer to the “Encoding Audio or Video Files” section
of this chapter.

2. In the templates pane, select a template, then depress Control key and
select any other desired number of template/bandwidth options.

3. Click Start to begin multiple template encoding.

4. The Multiple Template Encoding dialog box appears.

 Each template should be a different data rate, for example a 28Kbps
template, a 56 Kbps template and a 112 Kbps template.

5. Follow steps 15-16 for encoding audio and video files. For more
information, see the “Encoding a RealAudio or RealVideo File” section of
the “Using RealEncoder and RealPublisher” chapter.

6. Click Begin. The encoding process starts.

 The Multiple Template dialog box will remain visible during encoding,
and you will be able to monitor audio levels.

7. Click OK when the “Encoding Complete message” appears.

8. View the encoded file with RealPlayer.
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Command Line Encoding for Windows

In some situations you may find it convenient to encode live or on-demand
content within the DOS command line. The following syntax is used:

RVBatch RVEncode.exe <options>

where options are any of RealEncoder or RealPublisher options described
below.

Option Description ( defaults in parenthesis )

/I Use this option to specify an Input File

/O Use this option to specify an outfile or dir - Output File Name or
Directory (infile.rm or dir\YYYYMMDDHHMMSS.rm)

/L Use this option to specify Use Live Input

/S Use this option to specify "server[:port]/file" - Server Name,
Port and File. (Port 7070)

/W Use this option to specify password - Server Password

/D Use this option to specify hhh:mm:ss - Maximum Encoding
Duration (continuous)

/A Use this option to specify an Audio Codec (0)

/V Use this option to specify a Video Codec (0)

/F Use this option to specify a framerate - Frame Rate. (Optimal)

/B Use this option to specify Total Kbps for clip. (100)

/Q Use this option to specify Quality 1-100. (100)

/T Use this option to specify a Clip Title

/U Use this option to specify a Clip Author

/C Use this option to specify a Clip Copyright

/P Use this option to Enable Perfect Play. Valid options are:

0 Disabled
1 Enabled
(1)
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Option Description ( defaults in parenthesis )

/R Use this option to Enable Selective Record. Valid options are:

0 Disabled
1 Enabled
(0)

/X Use this option to Enable Audio Encoding. Valid options are:

0 Disabled
1 Enabled
(1)

/Y Use this option to Enable Video Encoding. Valid options are:

0 Disabled
1 Enabled
(1)

/? Use this option to Display the HELP information

Batch Encoding on Macintosh

Batch encoding on the Macintosh uses AppleScript. For more information,
refer to:

www.real.com
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Creating Templates

Each template is comprised of an audio codec, video bit rate, total bit rate,
quality and frame rate. The quality of encoding is affected by these settings and
by the actual content.

Content Elements that Affect Video Quality

Below are content elements that can affect the quality of a video encoding at 20
Kbps:

Content Type Expected Encoding Results

Fixed camera shot, low motion Clean frames, with high frame rates

Fixed camera shot, medium
motion

Clean frames, somewhat lower frame
rates

Multiple camera shots, low
motion

Clean frames with 1 fps or less

Zoom with low motion Clean frames with moderate frame rate

Fixed camera shot, high motion Clean frames with moderate frame rate

Multiple camera shots, high
motion

Clean frames with less than 1 fps

Note:  RealEncoder and RealPublisher produce significantly better frames with
higher frame rates when used with bandwidths higher than 28.8 Kbps.

RealVideo Total Bit Rates

RealVideo parameters that can be adjusted to obtain the preferred total bit rate
are as follows:

• audio codec

• video bit rate

• frame rate
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When deciding which parameters to set, the total bit rate must be considered.
The total bit rate is the actual bit rate at which the video or audio file is
encoded. If the target bit rate is 28.8 Kbps, then the total bit rate should be 20
Kbps. The following are the recommended total bit rates for common
bandwidths.

Target Bit Rate Total Bit Rate

28.8 Kbps 20 Kbps

56.0 Kbps (analog) 34 Kbps

56.0 Kbps (ISDN) 45 Kbps

64.0 Kbps (ISDN) 56 Kbps

128.0 Kbps (Dual ISDN) 105 Kbps

For a video file, select the total bit rate according to the table above, and then
choose an audio codec if you are using video with audio. For an audio only file,
choose a bit rate from the audio codec list only.

Command
Line

Parameter

Bandwidth Audio Codec

0 6.5 Kbps 6.5 Kbps voice

1 8.5 Kbps 8.5 Kbps voice

2 16 Kbps 16 Kbps music Low response

3 16 Kbps 16 Kbps music Medium response

4 16 Kbps 16 Kbps music High response

5 20 Kbps 20 Kbps music stereo

6 40 Kbps 40 Kbps mono

7 4 Kbps 40 Kbps stereo

8 80 Kbps 80 Kbps mono

9 80 Kbps 80 Kbps stereo

10 8 Kbps 8 Kbps music

11 12 Kbps 12 Kbps music

12 15.2 Kbps 15.2 Kbps voice

13 32 Kpbs 32 Kbps mono

14 15.2 Kbps 15.2 Kbps stereo
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Since RealAudio codecs have discreet bandwidths, the video bit rate is the
difference between the total bit rate and the bit rate of the chosen audio codec:

Video Bit Rate = (Total Bit Rate) - (Bit Rate of Audio Codec)

In RealEncoder and RealPublisher , the video bit rate is calculated
automatically. There are two video codecs:

Parameter Video Codec
0 RealVideo (Standard)
1 RealVideo (Fractal)

Next choose a frame rate. Not all content types support high frame rates for a
given bandwidth. The highest frame rate that can be achieved at 20 Kbps is 7.5
frames per second (fps) for Talking Head type content. Different content types
require different frame rates. For example, while Talking Heads at 20 Kbps
might support 7.5 fps, music videos only support 1 fps or less.

Note If you are getting high levels of latency, you are exceeding the bounds of
your content type. To solve high latency:

• Choose Optimize Frame Rate. This lets the encoder adjust the frame rate.

 You can select Optimized Frame Rate when using the RealVideo Standard
video codec. Optimized Frame Rate provides constant image clarity, or
sharpness, and variable frame rates. When this option is selected, the
encoder automatically selects the frame rate.

 For example, if a person who is talking begins to gesture or move around
quickly, the frame rate increases as the motion speeds up and decreases as
the motion slows down. The image sharpness remains constant throughout.

• Reduce the screen size (176 x 144 is recommended). Use numbers divisible
by 16 in setting frame size.

• Lower the frame rate.

 Fixed Frame Rate is adjusted by moving the slider. Fixed Frame Rate
gives you the option of choosing to emphasize image clarity or motion
smoothness.

 For example, if your content contains a lot of motion, set the slider closer
to the 15 fps setting. The resulting video image will be less clear but will
exhibit smoother motion, i.e., more frames per second.
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 However, if your content has less motion, set the slider closer to the .050
fps setting. The resulting video images will be more clear but will exhibit
less smooth motion, i.e. fewer frames per second.

Creating New Templates

Each audio-only template is comprised of an audio codec. Each video template
is comprised of an audio codec, video bit rate, total bit rate, frame rate, and
encoding speed. The quality of encoded output is affected by these and by the
actual media contents, such as fixed camera shots, more or less motion, and
multiple camera shots. If one of the templates does not achieve the effect you
are looking for, try creating a new template by basing it on a pre-defined
template and then modifying the settings.

To create a new template:

1. In the templates pane, click Advanced. The Advanced Setting window
appears:

2. Enter the name of the new template in the Template Name field and click
Save.

 You should not modify the pre-defined templates. If you want to change
some of the settings, save the template as a new template by giving it a new
name. This way you don’t overwrite the pre-defined templates.

3. Select an audio codec. They are arranged by data rate and type of content.

4. Select a Video codec. RealPublisher has two video codecs available, RealVideo
(Standard) and RealVideo (Fractal).

5. Select the total bit rate for the entire encoded file. The video bit rate will be
total bit rate less the audio bit rate.

 You should reduce the expected total bit rate by 25% to compensate for
connection and packet overhead. For example, choose 20 Kbps for a 28.8
Kbps modem.

6. Click Optimized Frame Rate or Fixed Frame Rate.
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• You can select Optimized Frame Rate when using the RealVideo Standard
video codec. Optimized Frame Rate provides constant image clarity, or
sharpness, and variable frame rates. When this option is selected, the
encoder automatically selects the frame rate.

 For example, if a person who is talking begins to gesture or move around
quickly, the frame rate increases as the motion speeds up and decreases as
the motion slows down. The image sharpness remains constant throughout.

• You can select Fixed Frame Rate when using the RealVideo Standard
video codec or the RealVideo Fractal video codec. Fixed Frame Rate is
adjusted by moving the slider. Fixed Frame Rate gives you the option of
choosing to emphasize image clarity or motion smoothness.

 For example, if your content contains a lot of motion, set the slider closer
to the 15 fps setting. The resulting video image will be less clear but will
exhibit smoother motion, i.e., more frames per second.

 However, if your content has less motion, set the slider closer to the .050
fps setting. The resulting video images will be more clear but will exhibit
less smooth motion, i.e. fewer frames per second.

7. Click Save to save the template.

8. Click Close to close the Advanced Settings window.
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Synchronized Multimedia

In addition to basic audio and video content, RealAudio and RealVideo System
allows you to create real-time on-demand multimedia presentations using the
RMMerge tool (Windows only). These presentations can be as simple as a
narrated slide show of your home page or as intricate as a multi-frame training
program that the viewer controls.

RealAudio and RealVideo includes the ability to synchronize World Wide Web
pages with audio. Thus the audio can be used as a “time line” to display new
pages or frames in the Web browser or to update its content. This enables the
creation of Internet slide shows, presentations, guided tours and site walk-
throughs. A user can have full random access (fast forward and rewind), and
the Web browser content is synchronized with the audio.

RealAudio and RealVideo System stores the information for the synchronized
events in a file with a .rm file extension. RealServer streams audio and event
information to RealPlayer. The event information is streamed to RealPlayer,
and in turn RealPlayer sends Web page information to the Web browser telling
it to update the page’s content.

Another way to create a synchronized multi-media presentation is using
RealPlayer Plug-in. However, since sending the Web browser to a new URL
unloads RealPlayer Plug-in when the HTML page is unloaded, it is best to
create separate frames for RealPlayer Controls and for the changing images.
For more information about frames, refer to the “Frames: The Basics” section
of the “Synchronized Multimedia” chapter.

Creating a RealVideo Events File

Creating a synchronized multimedia event using .rm files use the RMMerge
tool. This is a three-step process:

1. Use a text editor to create an input file specifying the display time for each
URL, title, author or copyright event.
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2. Use the RMMerge tool to generate a binary file from the text input file by
typing the following command:

rmmerge -f rmevents.dll events.txt audio_video.rm
outfile.rm

This command uses the user's events.txt file as input to the rmevents.dll.  It
makes a temporary .rm file that no one sees and merges that with the
audio_video.rm file to create outfile.rm.  The last filename on the command
line is always the final output file.  You can also do the following:

rmmerge -f rmevents.dll events.txt audio.ra video.rm
outfile.rm

 where:

event is the text file created in step 1
output is the .rm file that contains these events

3. Merge your new events .rm file with an audio or video file using the
following command:

rmmerge <event file> <audio or video file> <output
file>

 where:

 event file is the .rm file created in the previous step
 audio/video is the file merged with the event file
 output file is the file resulting from the merge

For example:

rmmerge event.rm audio_video.rm output.rm

Creating the Input File

Begin by creating a list of the URLs, titles, authors, or copyrights that you want
to be shown during your presentation and the times within RealAudio or
RealVideo clip when they should be displayed. The syntax for each entry
should follow the format (with a space between each part of the command):

u starttime endtime EventURL
i starttime endtime Title
a starttime endtime Author
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c starttime endtime Copyright

where:

u stands for URL event; each line starts with the letter u
i stands for title; each line starts with the letter i
a stands for author; each line starts with the letter a
c stands for copyright; each line starts with the letter c
starttime is the time into the clip when the new event is shown
endtime is the time into the clip when that event ends
EventURL (generally beginning with “http:” or “file:”) is the Internet
address for that event (usually an HTML document)

The time for starttime and endtime is:

[[[days:]hours:]minutes:]seconds[.tenths]

The lines of the input file must be in ascending order of start time. The end
time should be at least one tenth of a second before the start time of the next
event. The following example shows how an input file might look:

u 00:00:10.0 00:00:59.9 http://www.real.com/
u 00:01:00.0 00:02:00.0 http://www.mysite.com/ page2/

This input file tells RealPlayer to send the Web browser to the RealNetworks
home page ten seconds into the audio clip. One minute into the audio clip, the
Web browser displays a page from "www.mysite.com".

The input file may also contain comment lines beginning with the # symbol.
These comment lines are ignored by the event creation tool and are a good way
to document the date that the file was created and the type of information found
on each page.



RealAudio and RealVideo Content Creation Guide

58

Using Synchronized Multimedia with
Bandwidth Negotiation

When you deliver a Synchronized Multimedia presentation using Bandwidth
Negotiation, you can choose to deliver the same event for all encoding formats,
or you can choose to deliver different events for each encoding format.

You can create a single synchronized multimedia presentation for multiple
formats, or you can create a different multimedia presentation for each
encoding format. If you are working with previously created content, you can
continue to use the previous method to create presentations. For new content,
refer to the “Synchronized Multimedia” chapter.

For general information about Bandwidth Negotiation, refer to the “Bandwidth
Negotiation" chapter.

Frames: The Basics

Some Web browsers support a feature which allows the browser window to be
divided into multiple regions. Each region is called a frame and can display a
separate URL such as a graphic or document. For an introduction to frames
visit Netscape’s Web site at:

http://www.netscape.com

If you are unfamiliar with frames the following two sites provide a good
introduction:

Understanding Frames

http://www.netscape.com/navigate/understanding_frames.html

Frames: An Introduction

http://www.netscape.com/assist/net_sites/frames.html
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Editing Video Files

If you want to edit your video files, you have two options—you can edit your
.rm files, or you can edit your original source files.

Editing Input Files

Editing the original source files is the editing method of choice. Encoded video
is stored in indivisible clips of varying duration depending on the encoding
algorithm and the video bit rate. This limits how precisely encoded video can
be cut and pasted.

RealEncoder and RealPublisher are distributed with a Windows editing utility,
RMTools, and DOS: RMEdit, RMPaste and RMDump which enable simple
editing of RealVideo files.

Editing RealVideo Files in Windows

RMTools, the Windows 95 and Windows NT editing utility, is installed with
RealEncoder and RealPublisher. This utility enables you to perform three basic
editing tasks:

• Edit the file properties

• Examine the contents of a file

• Edit the data of a file.
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Editing File Properties

RMTools allows you to edit the static information about the file: title, author,
copyright, and comment; and the stream name and mime type for each
individual stream. You can also enable or disable PerfectPlay or Selective
Record. Editing the file properties does not affect the data.

To edit file properties of RealVideo files using RMTools:

1. Click Start. From Programs, select Real.

2. Select RealMedia Tools. The RealMedia Tools window appears. Notice
the window is divided into two panes, the source file pane on top and the
destination file pane on the bottom.

3. Select Open Source from the File menu. The Open File dialog box
displays. Select the file you want to edit. The file properties information is
displayed in the source file window.

4. To sort by the stream attribute, click the column. You can also resize the
columns by placing the cursor over the column border and then clicking-
and-dragging.

5. Select File Properties from the Edit menu. The File Properties dialog box
appears. The file name is displayed in the source box and in the destination
box. New file names can be selected by clicking Browse and selecting a
new file from the dialog box.

6. To save changes to the existing file, do not change the destination file name.
To save the changes to a new file, click Browse to select or enter a different
name in the destination box.

7. Type the new title name, author, copyright information, and any comment
in the appropriate boxes. (You can also type a new title, author, copyright,
or comment directly in the fields on the source and destination panes.)

8. The total number of streams is listed in the Stream Properties box. If you
want to change the name or the mime type of one stream, select the stream
to be changed by clicking the up or down arrow.

9. If you want to change the stream name, type the new name in the Stream
Name box.
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10. Changing the mime type is recommended for advanced users only. If you
are certain you wish to change the mime type, type the new mime type in
the Mime Type box. If you change the mime type, the following warning
will appear after you have applied the changes.

9. Click PefectPlay to allow RealPlayer users with low bandwidth modems to
experience files encoded for a higher bandwidth. Selecting PerfectPlay will
partially download video data before beginning playback.

10. If you want to allow RealPlayer Plus users to save your clip to disk, click
Selective Record.

11. Click Apply. The changes are applied to the file and displayed in the
source file pane of the RealMedia Tools window.

Examining the Contents of a RealVideo File

RMTools enables you to view the contents of an .rm file by dumping the
contents to a text file. You can then edit or print the file as you would any other
text file.

To examine the contents of a RealVideo file:

1. Select New Session from the File menu.

2. Open the Source file from the File menu. The file information is displayed
in the source pane.

3. Select Dump from the File menu. The Dump As dialog box appears. The
default name is the same as the source file name, with the extension
changed to .txt. You may also select or enter another dump file name.
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4. Click Save. When prompted to view the file now, click Yes.

5. The following error message may appear. If so, click Yes. The Notepad or
WordPad window displays the contents of the file. For an example of an
.rm text file, refer to “Command Line Editing of RealVideo Files” of the
“Editing Video Files” chapter.

6. You can view, edit, and print the file just as you would any other text file.

Editing RealVideo Data

RMTools allows simple editing of .rm files. You can put multiple clips in one
file; you can shorten the length of a clip; and you can take a video stream from
one file and add the audio stream from another file. When working with more
than one file, streams of the same mime type must have the same encoding
parameters if they are going to be pasted together.

To place two RealVideo clips in one file:

1. Select New Session from the File menu.

2. Select Open Source from the File menu. The Open File dialog box appears.

3. Select the file you want to edit. Click Open. The source file pane displays
the stream number, the stream name, mime type, and the start and end
times.

4. Select Copy from the Edit menu. The Copy dialog box appears.

5. In the Stream Number box, accept the default, All Streams.

6. Do not change the start and end times. Click Copy.

7. Select Paste from the Edit menu. The Paste dialog box appears.

8. Click Paste. The destination pane displays the stream number, source file,
mime type, start time and end time.

9. Right-click the source pane. A shortcut menu appears. Click Open Source.
Choose a second clip to be added at the end of the first clip. (Both clips
must have the same encoding parameters.)
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10. Click Open. The source pane displays the information from the new file
while the destination pane displays the information from the streams that
were previously pasted.

11. Select Copy from the Edit menu.

12. Accept the default, All Streams, and the start and end times. Click Apply.

13. Right-click the destination pane. A shortcut menu appears. Click Paste.
The Paste dialog box appears. The previous end time displays as the new
start time.

14. Click Paste. The second clip is listed below the first clip.

15. If the following warning displays, you must select a different clip or re-
encode the clip so that the encoding parameters are the same.

16. Select Save As from the File menu. The Save As dialog box appears.

17. Type the new file name. Click Save.

18. Use RealPlayer to view the new file.

To put the video stream of one file with the audio stream of another:

1. Select New Session from the File menu.

2. Select Open Source from the File menu. The Open File dialog box appears.

3. Select the first file you want to edit. Click Open. The source file pane
displays the information from the file.

4. Select Copy from the Edit menu. The Copy dialog box appears.

5. In the Stream Number box, select the stream that contains the video. Click
Copy.

6. Select Paste from the Edit menu. The Paste dialog box appears.

7. Click Paste. The destination pane displays the information from the new
file. Notice only the video stream has been pasted into the destination pane.

8. Right-click the source file pane. A shortcut menu appears. Click Open
Source.
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9. Choose a second file with the same encoding parameters as the first clip,
and of approximately the same duration. Click Open. The source pane
displays the information from the file.

10. Right-click the source pane. A shortcut menu appears. Click Copy. The
Copy dialog box appears.

11. In the Stream Number box, select the stream that contains the audio. Do
not change the start and end times.

12. Click Copy.

13. Right-click the destination pane. A shortcut menu appears. Click Paste.
The Paste dialog box appears.

14. Click Paste. The audio stream is listed below the video stream. Notice both
streams have the same start time, and should have similar end times.

15. Select Save As from the File menu. The Save As dialog box appears.

16. Type the new file name. Click Save.

17. Use RealPlayer to view the new file.

Command Line Editing of RealVideo Files

The RealVideo file editing tools, RMCut, RMPaste, RMEdit, and RMDump are
run from a DOS command line. The RMCut tool is used to cut a specific
portion of a RealVideo file without changing the original source. The RMPaste
tool is used to combine two or more RealVideo files. The RMEdit tool is used to
modify the title, author, copyright, comment, mime type, or stream name. It can
also be used to print the current values for the file or stream. The RMDump
tool is used to examine the contents of a RealVideo file.

Editing RealVideo Files

RMEdit has five separate forms. The first form modifies any or all of the title,
author, copyright, and comment for the file.
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rmedit -i <input> -o <output> [-t <title>]
[-a <author>] [-c <copyright>] [-C <comment>]

The second form modifies any or all of mime type and stream name for the
selected stream.

rmedit -i <input> -o <output> (-S <stream number>
[-m <mimetype>] [-s <stream name>])

The third form prints out the current values for the file and for each stream that
RMEdit is capable of modifying.

rmedit -i <input>

The fourth form sets or clears Perfect Play mode and Selective Record.

rmedit -i <input> -o <output> [-r [ON|OFF]] [-p
[ON|OFF]]

The fifth form prints the RMDump version and copyright notice.

rmedit -v

where:

<input> is the path and file name to the input file.
<output> is the path to the output file that contains the edited file.
<title> is the title text.
<author> is the author text.
<copyright> is the copyright text.
<comment> is the comment text.
<stream number> is the stream number for the following two
parameters. (May be repeated for any number of streams.)
<mimetype> is the mimetype for a specified stream.
<stream name> is the stream name for a specified stream.
-v prints the RMDump version and copyright notice.
-p is the perfect play mode.
-r is the set/clears selective record.
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Note Only valid mime types (those accepted by the player) should be entered
in the mime type field.

Note Input and output file names must not be the same.

The following examples demonstrate the use of the RMEdit tool:

1. To create a new file modifying the title, enter:

 rmedit -i original.rm -onewfile.rm -t ”My New
Title”

2. To change the stream name of stream 1, enter:

 rmedit -i original.rm -onewfile.rm -S1 \

 -s ”New Stream Name”

3. To display the current contents of the file, enter:

rmedit -i original.rm

Note Long file names are acceptable, but file names containing spaces must be
contained in quotes.

Cutting RealVideo Files

Use the RMCut tool to cut a specific portion of a RealAudio or RealVideo file
without modifying the original source. A cut is made by setting the start and
end times for individual streams. Not entering a start time defaults to the
beginning of the file and likewise, not entering an end time defaults to the end
of the file. RMCut can be used without RMPaste to remove the front or end of a
file.

To create a copy of a piece of a RealAudio or RealVideo file:

1. View your original RealAudio or RealVideo file to determine the start and
end times of the segment you want to copy (you can read the times on the
status bar of RealPlayer).

2. Create a copy by typing:

rmcut -i <input> ([-S <stream>] [-s <start>] \
[-e <end>]) -o <output> -v
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where:

<input> is the path to the input file
<stream> is the stream number. If not specified, all streams are
used. It can be repeated to grab one or more streams.
<start> is the start time in
Days:Hours:Minutes:Seconds.Milliseconds format. If missing, this
parameter defaults to the beginning of the file.
<end> is the end time in Days:Hours:Minutes:Seconds.Milliseconds
format. If missing, this parameter defaults to the end of the start+input
length. (Multiple start end sequences can be used to cut discontinuous
portions of the stream.)
<output> is the path to the output file that contains the edited file.
-v is the print version and copyright notice

Note: An image map stream’s start and end times must go from the beginning
to the end of the file. Use RMCut to strip out the image map before working
with the RealAudio or RealVideo file. Then, to alter and re-merge the image
map file with the video image, refer to “Image Maps” section in the “Editing
Video Files” chapter.

The following examples demonstrate the use of the RMCut tool.

1. To create a new file with only stream zero, enter:

 rmcut -i source.rm -o cutfile.rm -S0

2. To create a new file with the first 30 seconds of stream 0:

 rmcut -i source.rm -o cutfile.rm -s0.0 -e30.0

3. To create a new file with the first 30 second of stream 0 and with the first
45 seconds of stream 1, enter:

 rmcut -i source.rm -o cutfile.rm \
 -S0 -s0.0 -S1 -s0.0 -e45.0

Examining the Contents of RealVideo Files

RMDump is used to examine the contents of a RealAudio or RealVideo file.
RMDump accepts two input parameters: the input file and the output file.

To use RMDump, type:

rmdump -i <infile> -o <outfile>
rmdump -v
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Where:

<infile> is the input .rm extension file
<outfile> is the output text file (use a text editor to view)
<-v> prints the RMDump version and copyright notice.

An example of how to run RMDump is shown below:

Example

>rmdump -i input.rm -o out.txt
dumping input.rm to out.txt . . .
dumping realmedia headers . . .
dumping stream packets
dumping stream 0 . . .
dumping stream 1 . . .
done
! Elapsed time = 556 milliseconds

The next step is to use an editor like Notepad on Windows NT/95 to examine
the contents of the RMDump.

RealMedia File: input.rm
================
RM_HEADER_OBJECT
... deleted to save space ...
====================
RM_PROPERTIES_OBJECT
... deleted to save space ...
====================
RM_CONTENT_OBJECT
... deleted to save space ...
==========================
RM_MEDIA_PROPERTIES_OBJECT
object_id: 0x4D445052 (RPDM)
size: 155 bytes
object version: 0
stream_number: 0
max_bit_rate: 12062 bps
avg_bit_rate: 12062 bps
max_packet_size: 288 bytes
avg_packet_size: 288 bytes
start time: 0 milliseconds
preroll: 191 milliseconds
duration: 224898 milliseconds
stream_name: The Audio Stream
mime_type: audio/x-pn-realaudio
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type_specific_length: 73
==========================
RM_MEDIA_PROPERTIES_OBJECT
object_id: 0x4D445052 (RPDM)
size: 116 bytes
object version: 0
stream_number: 1
max_bit_rate: 7000 bps
avg_bit_rate: 7000 bps
max_packet_size: 668 bytes
avg_packet_size: 564 bytes
start time: 0 milliseconds
preroll: 3474 milliseconds
duration: 228000 milliseconds
stream_name: The Video Stream
mime_type: video/x-pn-realvideo
type_specific_length: 34
====================
RM_DATA_OBJECT
... deleted to save space ...
==========================
Seek Time: 1 with reqtime = 0 and actualtime = 0
packet 0: stream 0 timestamp 0 size: 288 keyframe
packet 1: stream 1 timestamp 0 size: 639 keyframe
packet 2: stream 1 timestamp 0 size: 619 keyframe
packet 3: stream 1 timestamp 0 size: 599 keyframe
packet 4: stream 1 timestamp 0 size: 544 keyframe
packet 5: stream 1 timestamp 0 size: 639 keyframe
packet 6: stream 0 timestamp 192 size: 288 keyframe
packet 7: stream 0 timestamp 384 size: 288 keyframe
packet 8: stream 0 timestamp 575 size: 288 keyframe
packet 9: stream 0 timestamp 767 size: 288 keyframe
packet 10: stream 0 timestamp 958 size: 288 keyframe
packet 11: stream 0 timestamp 1150 size: 288 keyframe
packet 12: stream 0 timestamp 1341 size: 288 keyframe
packet 13: stream 0 timestamp 1533 size: 288 keyframe
packet 14: stream 0 timestamp 1724 size: 288 keyframe
packet 15: stream 0 timestamp 1916 size: 288 keyframe
packet 16: stream 0 timestamp 2108 size: 288 keyframe
packet 17: stream 0 timestamp 2299 size: 288 keyframe
packet 18: stream 0 timestamp 2491 size: 288 keyframe

The RM_MEDIA_PROPERTIES_OBJECT sections describe the stream type
and stream number for each stream.

- The keyframe field is used to identify the start of a series of related packets.
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- Keyframes are sometimes too large to form a single packet. In this case
multiple keyframes will be seen with the same timestamps.

- Some codecs produce packets with the keyframe flag always set. And
others produce a mixture of keyframe and non keyframe packets.

- Packet sizes can be identical in size or vary in size within a single stream.

- The RM_MEDIA_PROPERTIES_OBJECT sections contain attributes of
each stream which include:

1. The stream number.

2. The stream type.

3. The total stream type (audio or video).

4. The total duration of the stream in milliseconds.

5. The preroll which describes how long to load buffers into the player
before playing the stream.
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Combining RealVideo Files

RMPaste assumes that streams on the input side are joined to streams on the
output side based upon their mime types. Start and End times are specified to
map the input file, which may contain one or more streams, to a new time
range in the output file. Only one file can use default start and end times. Start
and end times must not overlap. If streams overlap, packets from both streams
are intermingled based upon timestamp.

rmpaste (-i <input> [-s <start>] [-e <end>]
[-f <from stream> -t <to stream>]) -o <output> -v

where:

<input> is the path to the input file. There can be one or more -i -s -e
parameters sequences.
<start> is the start time in Days:Hours:Minutes:Seconds.Milliseconds
format. If missing this parameter defaults to the beginning of the file.
<end> is the end time in Days:Hours:Minutes:Seconds.Milliseconds
format. If missing this parameter defaults to start+input length.
<output> is the path to the output file that contains the edited file.
<from stream> is the input stream number to be sent to the to stream.
<to stream> is the output stream number.
-v is the print version and copyright notice.

Note RMPaste can paste in additional streams and add to existing streams.
When streams are pasted together, the timestamps must not overlap.

Note If multiple streams are in the input file and the timestamps of the
streams do not start at the same time, the start time applies to the earliest
stream in the file. The start time plus the difference between the streams first
packet is used for the remaining streams. See first example.

The following examples demonstrate the use of the RMPaste tool:

1. If you cut three streams from a source file using:

rmcut -i source.rm -o cutfile1.rm \
-S0 -s10.0 -S1 -s20.0 -S2 -s30.0
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resulting in an output file like:

Times

Stream0: 0.3 1.1 ….

Stream1: 10.4 12.4 ….

Stream2: 22.0 32.0 ....

and mapped it using:

rmpaste -i cutfile1.rm -s5.0 \
-i cutfile2.rm -e5.0 \
-o paste.rm

the new stream times for cutfile1.rm would be:

Times

Stream0: 5.3 6.1 ….

Stream1: 15.4 17.4 ….

Stream2: 27.0 37.0 ....

with cutfile2.rm placed from the beginning of the file to 5 seconds into the
file. (packets not shown)

2. To create a new file using the first 60 seconds of the source.rm file
swapping the first 45 seconds with the next 15 seconds in the file enter:

rmcut -i source.rm -o cutfile1.rm -s0.0 -e45.0
rmcut -i source.rm -o cutfile2.rm -s45.0 -e60.0
rmpaste -onewfile.rm -icutfile2.rm -s0.0 -e15.0 \
-icutfile1.rm -s15.0 -e60.0

3. To add a new stream to an existing file:

rmpaste -ioriginal.rm -inewstream.rm -onewfile.rm
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Image Maps

"Click-able" image maps allow users to interact with the video content by
adding image-specific video seeking and URL commands. Image maps are fully
customizable; actions can be connected to rectangular, circular or polygonal
content regions and can be varied over specific user-defined time intervals.

To create Image Maps:

1. Create an Image Map File (text file).

2. Merge the Image Map file (with a .rm file).

Creating an Image Map File

Image Map Files are text files that have HTML-like tags which specify the
location and action of each image map. Image map files should be created in a
text editor and saved as text only.

All tags shown below are required unless otherwise stated. Negative values for
numbers are not allowed.

DURATION Tag

This tag must be at the beginning of the file. The DURATION tag specifies the
amount of time from the start time of the first map to the end time of the last
map in the file. The format is as follows:

DURATION=x:x:x:x:x

Tag Name Description

DURATION Times are specified in the following format:
Days:Hours:Minutes:Seconds:MilliSeconds. All of the
these fields must be present. That means if you don't
want to specify a particular setting, fill 0's in that space.
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MAP Tag

This line describes the overall properties of the image map. The format is as
follows:

<MAP START=x:x:x:x:x END=x:x:x:x:x COORDS=x,y,x1,y1>

Tag Name Description

START Times are specified in the following format:
Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields
must be present. That means if you don't want to specify a particular
setting, fill 0's in that space. If START contains all 0's then the start
of the clip is assumed.

END Times are specified in the following format:
Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields
must be present. That means if you don't want to specify a particular
setting, fill 0's in that space. If END contains all 0's then the end of
clip is assumed.

COORDS Specifies the rectangle that this entire map is going to occupy. If you
enter an area bigger than the entire display area, the entire area is
active. Any area not located within this rectangle will be clipped.

You may have as many MAP tags in a file as you wish.

AREA Tag

There can be 0 to 40 area lines in an image map. These lines describe the
different regions that are active within an image map.

<AREA START=x:x:x:x:x END=x:x:x:x:x SHAPE=XXXX
COORDS=x0,y0,x1,y1,x2,y2,…xn,yn action_tag ALT="" >
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Tag Name Description

START Specifies the start time of this area during the map. This field is
optional; if you do not include a START time, the area begins at the
beginning of the map time. Times are specified in the following format:
Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields must
be present. That means if you don't want to specify a particular setting,
fill 0's in that space. If START contains all 0's then the start of the
current map is assumed.

END Specifies the end time of this area during the map. This field is optional;
if you do not include an END time, the area ends at the end of the map
time. Times are specified in the following format:
Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields must
be present. That means if you don't want to specify a particular setting,
fill 0's in that space. If END contains all 0's then the end of map is
assumed.

Note If the start and end times of an area are outside the start and end
times of the map, then the start and end times of the map are used.

SHAPE The XXXX for the SHAPE tag can be one of the following values:
(CIRCLE, RECTANGLE, POLYGON).

CIRCLE - COORDS tag should specify three values:
centerX,centerY,radius

RECTANGLE - COORDs tag should specify four values:
left,top,right,bottom

POLYGON - COORDs tag should specify at least 6 values (x and y
coordinates for at least 3 points). These are the vertices for the polygon.

action_tag The action_tag is one of the following: PLAYER, URL, SEEK.

PLAYER - Used to specify a new stream to play with RealPlayer. For
example:

PLAYER="pnm://video.real.com/welcome.rm"

URL - Used to specify a new URL to display in a browser. For example:
URL="http://www.real.com"

SEEK - Used to specify a time within the current clip to seek to. For
example:

SEEK=0:0:0:5:0.

Note the format is just like the START and END tags.

ALT The ALT tag contains text that appears in the status bar of the
player when the mouse is over this AREA and it is active. If you
want no text then use "" as shown above.
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/MAP Tag

This line means you are done with the current image map.

Example
DURATION=0:0:0:40:0

<MAP START=0:0:0:0:0 END=0:0:0:5:20 COORDS=0,0,100,100>

<AREA SHAPE=CIRCLE COORDS=50,50,10
URL="http://www.real.com" ALT="Home Page">

</MAP>

<MAP START=0:0:0:5:20 END=0:0:0:20:3 COORDS=0,0,100,100>

<AREA SHAPE=RECTANGLE COORDS=0,0,50,50 SEEK=0:0:0:3:98
ALT="Seek to a point in the clip">

</MAP>

<MAP START=0:0:0:20:3 END=0:0:0:40:0 COORDS=0,0,100,100>

<AREA END=0:0:0:30:0 SHAPE=POLYGON COORDS=0,50,50,0,100,50
PLAYER="pnm://video.real.com/welcome.rm" ALT="">

<AREA START=0:0:0:31:0 SHAPE=POLYGON
COORDS=0,25,25,0,100,50 SEEK=0:0:0:0:0 ALT=”Rewind to
Beginning”>

</MAP>

Merging an Image Map file with a Video Image

When you have finished creating the Image Map file, you convert the Image
Map text file into a .rm file using the RMMerge tool that is installed with
RealEncoder and RealPublisher . Then, you merge that .rm file with an
encoded video (.rm) file.

To convert the Image Map file into a .rm file:

1. From a DOS command line, change directories to the directory that
RealEncoder or RealPublisher was installed, which by default is
C:\REAL\RVENCODE

2. Enter the following command:

rmmerge -f rmimap.dll image_map_text image_map_rm
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 Done..... appears when the image map text file has been converted to a .rm
file.

 Note If you receive the message Error Parsing file, verify that the Image
Map file is saved as text only and the tags are used correctly.

3. Merge the Image Map .rm file with a video (.rm) file by typing the
following command:

rmmerge image_map_rm video_rm final_rm

 The final_rm file contains your Image Map as well as the audio/video clip.

4. Verify the Image Map by playing the final_rm file with RealPlayer.

Modifying RealVideo File Descriptions

You can change the Title, Author, or Copyright text, and modify the Selective
Record and PerfectPlay settings in a .rm file using several different methods:

Method Description

RMTools The is the editing tool available for Windows 95 and
Windows NT.

Refer to the “Editing File Properties” section of this
chapter.

RMEdit Tool This is a command line tool available for Windows.

Refer to the “Command Line Editing of RealVideo
Files” section  in the “Editing Video Files” chapter.

.ram File Set the Title, Author, and Copyright text strings in
the .ram file.
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Bandwidth Negotiation

You can encode your files with different compression rates based on the
bandwidth capability of the user. You can choose to provide as many different
data rates for each file as you want.

The Player gets the best quality the connection can handle without having to
explicitly choose among multiple links and Web pages. You can choose to
provide as many different data rates for each file as you want. The bandwidth
negotiation process is transparent to users.

Bandwidth negotiation requires only one link on your Web site to a particular
clip. To provide content in multiple formats without bandwidth negotiation,
your Web site must have a separate hypertext link and metafile for each format.

Creating Files with the Bandwidth
Negotiation Option

To create a web page that uses the Bandwidth Negotiation option:

1. Start RealPublisher from your desktop and follow steps 1-13 for encoding
audio and video files. See the “Encoding an Audio or Video File” section
in the chapter “Using RealEncoder and RealPublisher) for more
information.

2. In the encoding templates listbox, select a template, then depress Control
key and select any other desired number of templates.

3. Click Start to begin multi-template template encoding.

4. Typically, each template should be a different data rate.  For example you
might choose a 28Kbps template, a 56 Kbps template and a 112 Kbps
template.
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5. The Multiple Template Encoding dialog box appears. Verify that Enable
Bandwidth Negotiation is selected. The files will automatically be named
for the server.

6. Follow steps 15-16 for encoding audio and video files. See the “Encoding
Audio or Video Files” section of the “Using RealEncoder and
RealPublisher” chapter.

7. Click Begin. The encoding process starts.

 The Multi-Template dialog box will remain visible during encoding, and
you will be able to monitor audio levels.

8. Click OK when the “Encoding Complete” message appears.

9. View the encoded file with RealPlayer.

Bandwidth File Organization

File organization is the key to bandwidth negotiation. This figure shows a
single link on a Web page, and seven available RealVideo files encoded using
different algorithms.
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The following steps correspond to the numbers in the figure:

1. The user clicks a link to a metafile on a Web page.

2. The Web server returns the metafile to the Web browser and based on the
.ram file extension, sets the MIME type of the metafile to audio/x-pn-
RealAudio.

3. The Web browser looks up the MIME type of the metafile, starts
RealPlayer as a helper application, and passes it the metafile.

4. RealPlayer reads the first URL from the metafile and requests it from
RealServer. Based on its preference settings, RealPlayer also sends a list of
RealVideo compression types it supports.

5. RealServer checks the directory specified by the URL and begins streaming
the highest bandwidth file supported by RealPlayer.

The following table shows the metafile for each bandwidth and connection for
RealVideo clips.

1

4

3

2

5

Web Server

Link to Metafile

                file.ram

Web Browser

RealPlayer  Folder

      pnrv.1930

      pnrv.144

      pnrv.70

      pnrv.43

      pnrv.36

      pnrv.24

      pnrv.18

Real Server
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Connection Bandwidth (bps) File Name

T1 1544000 pnrv.1930

Dual ISDN 115200 pnrv.144

Single ISDN 56700 pnrv.70

56.6 56700 pnrv.43

28.8 28800 pnrv.36

19.2 19200 pnrv.24

14.4 14400 pnrv.18
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The following table shows the file formats that RealAudio Player version 1.0
through 3.0 requests and order in which they are requested:

Player Version Bandwidth Setting Files Requested

1.0 All 14_4.18

2.0 14.4 14_4.18

2.0 28.8, ISDN, T1 28_8.36
14_4.18

2.1 14.4 14_4.18

2.1 28.8, ISDN, T1 28_8.36
14_4.18

3.0 14.4 14_4.18

3.0 28.8 dnet.25
dnet.20
28_8.36
14_4.18

3.0 ISDN dnet.50
dnet.25
dnet.20
28_8.36
14_4.18

3.0 T1 dnet.100
dnet.50
28_8.36
dnet.25
dnet.20
14_4.18

Note: RealAudio Player 3.0 with a 28.8 Kbps connection always plays
RealAudio 2.0 - 28.8 (28_8.36) format if it is available. If you want to provide
another 28.8 format such as 28.8 Stereo (dnet.25), do not also provide the
28_8.36 format. If you do not provide any format supported by a Player, that
Player receives a message to upgrade to the current Player release.
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The following table shows the file formats that RealPlayer 4.0 and 5.0 requests
and in what order they are requested.

Player Version Bandwidth Setting Files Requested

4.0 28.8 pnrv.36
dnet.25
pnrv.24
dnet.20
28_8.36
pnrv.18
dnet.15
sipr.12
14_4.18

4.0 ISDN pnrv.1930
pnrv.144
dnet.100
pnrv.70
dnet.50
pnrv.36
dnet.25
pnrv.24
dnet.20
28_8.36
pnrv.18
dnet.15
sipr.12
dnet.10
sipr.10
14_4.18
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Player Version Bandwidth Setting Files Requested

4.0 Dual ISDN pnrv.1930
pnrv.144
dnet.100
pnrv.70
dnet.50
pnrv.36
dnet.25
pnrv.24
dnet.20
28_8.36
pnrv.18
dnet.15
sipr.12
dnet.10
sipr.10
14_4.18

4.0 T1 pnrv.1930
pnr.144
dnet.100
pnrv.70
dnet.50
pnrv.36
dnet.25
pnrv.24
dnet.20
28_8.36
pnrv.18
dnet.15
sipr.12
dnet.10
sipr.10
14_4.18
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Player Version Bandwidth Setting Files Requested

5.0 28.8 pnrv.36
dnet.25
pnrv.24
dnet.20
28_8.36
pnrv.18
dnet.15
sipr.12
14_4.18

5.0 56.6 pnrv.1930
pnrv.144
dnet.100
pnrv.70
dnet.50
pnrv.43
pnrv.36
dnet.25
pnrv.24
dnet.20
sipr.20
28_8.36
pnrv.18
dnet.15
sipr.20
sipr.12
sipr.6
14_4.18
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Player Version Bandwidth Setting Files Requested

5.0 ISDN pnr.1930
pnrv.144
dnet.100
pnrv.70
dnet.50
pnrv.43
pnrv.36
dnet.25
pnrv.24
dnet.20
sipr.20
28_8.36
pnrv.18
dnet.15
sipr.12
dnet.10
sipr.10
sipr.6
14_4.18

5.0 Dual ISDN pnrv.1930
pnrv.144
dnet.100
pnrv.70
dnet.50
pnrv.43
pnrv.36
dnet.25
pnrv.24
dnet.20
sipr.20
28_8.36
pnrv.18
dnet.15
sipr.12
dnet.10
sipr.10
sipr.6
14_4.18
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Player Version Bandwidth Setting Files Requested

5.0 T1 pnrv.1930
pnrv.144
dnet.100
pnrv.70
dnet.50
pnrv.43
pnrv.36
dnet.25
pnrv.24
dnet.20
sipr.20
28_8.36
pnrv.18
dnet.15
sipr.12
dnet.10
sipr.10
sipr.6
14_4.18

The following table shows the file formats that RealPlayer 4.0 requests from
RealAudio servers 1.0 through 3.0, and RealServer in the order they are
requested. The unshaded file formats can be played in real time. The file
formats shaded in gray can be played, but the player will use a buffered
playback mechanism to play the file.
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T1/LAN Dual
ISDN

ISDN 56.6 28.8 19.2 14.4

pnrv.1930 pnrv.144 pnrv.70 pnrv.43 pnrv.36 pnrv.24 pnrv.18

pnrv.144 dnet.100 dnet.50 pnrv.36 dnet.25 dnet.20 dnet.15

dnet.100 pnrv.70 pnrv.43 dnet.25 pnrv.24 28_8.36 sipr.12

pnrv.70 dnet.50 pnrv.36 pnrv.24 dnet.20 pnrv.18 dnet10

dnet.50 pnrv.43 dnet.25 dnet.20 28_8.36 dnet.15 sipr.10

pnrv.43 pnrv.36 pnrv.24 sipr.20 pnrv.18 sipr.12 14_4.18

pnrv.36 dnet.25 dnet.20 28.8.36 dnet.15 dnet10 28_8.36

dnet.25 pnrv.24 sipr.20 pnrv.18 sipr.12 sipr.10 dnet.20

pnrv.24 dnet.20 28_8.36 dnet.15 dnet10 14_4.18 pnrv.24

dnet.20 sipr.20 pnrv.18 sipr.12 sipr.10 dnet.25 dnet.25

sipr.20 28_8.36 dnet.15 dnet.10 14_4.18 pnrv.36 pnrv.36

28_8.36 pnrv.18 sipr.12 sipr.10 dnet.50 dnet.50 dnet.50

pnrv.18 dnet.15 dnet10 sipr.6 pnrv.70 pnrv.70 pnrv.70

dnet.15 sipr.12 sipr.10 14_4.18 dnet.100 dnet.100 dnet.100

sipr.12 dnet10 sipr.6 dnet.50 pnrv.144 pnrv.144 pnrv.144

dnet10 sipr.10 14_4.18 pnrv.70 pnrv.1930 pnrv.1930 pnrv.1930

sipr.10 sipr.6 dnet.100 dnet100

sipr.6 14_4.18 pnrv.144 pnrv144

14_4.18 pnrv.1930 pnrv.1930 pnrv.1930
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Bandwidth Negotiation Example

In this example, you deliver one of three RealVideo formats depending on the
connection speed and RealPlayer version.

To setup this example:

1. Encode the source file in the following formats:

• RealMedia 20 Kbps Video - 6.5 Kbps Audio

• 45 Kbps Video - 16 Kbps Audio

• 100 Kbps Video - 40 Kbps Stereo

2. Create a metafile named myvideo.ram containing a URL such as:

pnm://www.real.com/music/myvideo.rm

3. Create a link to the metafile in a Web page. The following HTML code is a
typical link:

<A HREF="http://www.real.com/myvideo.ram">
Watch myvideo</A>

4. On RealServer computer, create a directory named myvideo.rm in the
/music directory.

5. In this directory, store the three files, renamed pnrv.24, etc. as shown in
the previous table.

 The file that is played depends on the Player connection and version:

• ISDN or faster connection with RealPlayer 3.0 or later: RealAudio 3.0
- ISDN Stereo format (dnet.50)

• 28.8 Kbps connection with RealAudio Player 3.0 or later: RealAudio
3.0 - 28.8 Stereo format (dnet.25)

• 14.4 Kbps connection with RealPlayer 3.0 or later: RealAudio 2.0 -
14.4 format (14_4.18)
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• 14.4 Kbps or faster connection with RealAudio Player version 2.1 and
earlier: RealAudio 2.0 - 14.4 format (14_4.18)
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Publishing Your Pages to the
Web

RealPublisher is an enhanced version of RealEncoder and offers Web
publishing features including:

• automatic HTML page creation

• easy uploading of HTML pages to either a standard HTTP web server or a
RealServer streaming media server

Creating Web Pages (HTML)

A primary feature of RealPublisher is the HTML Generation Wizard. With it
you can automatically create an HTML page that contains your encoded media
file, and play back the media file through your Web browser.

The wizard leads you a series of prompts to help you create the HTML file and
choose how your web page will look displayed either with a Pop-up Real Player
Embedded RealPlayer. The wizard then allows you to preview the finished
page.

The Pop-up RealPlayer application is launched and run from the browser and
uses a standard display window and controls. The Embedded RealPlayer is a
Netscape or Active X Plug-in that allows you to integrate components of
RealPlayer within your web page. With it, you can also customize the controls
and design of your web page.

To create a web page displaying a pop-up RealPlayer (single audio or video data
rate file):

1. Start RealPublisher. The RealPublisher window opens.

2. Click Create HTML. The HTML Generation Wizard window appears.
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3. Click Next to select a media file. The Media File page appears.

4. Click Encoded File.

 Please note: If you are creating a web page for bandwidth negotiated files
click Bandwidth Negotiation.

5. The name of the last file encoded appears by default: If you wish to use the
default file, click Next.

6. To select the name of a different file, click Browse. The Select File dialog
box appears. Select the file and click Open.

7. The Playback Method page appears. Click Next.

8. Click Pop-Up Player and  click Next.

9. The RealMedia caption name page appears. This name is what viewers
will will use to select this content.

10. Enter caption name and click Next.

11. The Filename page appears. Enter name of HTML file you want to create
and click Next.

12. If you wish to preview your HTML page with a web browser, click Preview
HTML on the Results page.

13. When preview is completed, click Finish.

To create a web page displaying an embedded RealPlayer (single audio or video
data rate file):

1. Follow steps 1-6 for displaying pop-up RealPlayer

2. Click Embedded RealPlayer and click Next.

3. The Player Control page appears. Select player control layout from the
available templates. Click Next.

4. Select player control layout from the available templates and click Next.

5. Click Auto Start if you wish the RealAudio or RealVideo file to
automatically launch when web page is displayed.
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6. The RealMedia caption appears. This name is that viewers will use to
select this content.

7. Enter caption name and select caption placement by clicking Place
Caption Above Embedded Player button or Place Caption Below
Embedded Player button. Click Next.

8. The Filename page appears. Enter name of HTML file you want to create
and click Next.

9. If you wish to preview your HTML page with a web browser, click Preview
HTML on the Results page.

10. When preview is completed, click Finish.

Automatic creation of metafiles

A metafile connects a web page to one or more RealAudio or RealVideo clips
located on a remote server. The function of a metafile is to “point” to the
locationwhere your media file actually resides and it is required for your file to
“stream”, not just download and play.  Typically, a metafile is located on the
web server and contains the URL where your RealAudio or RealVideo clips can
be found.

Metafiles are automatically created and updated by RealPublisher during the
web page creation and publishing steps.

Publishing your files

Another primary feature of RealPublisher is the Publish to Server Wizard. This
allows users to publish their RealAudio and RealVideo enabled web page to a
remote server. The server can be either a RealServer streaming media server or
a standard HTTP web server using a standard FTP protocol.

The wizard leads you through a series of prompts to help you specify the type of
server and the directory where you will upload your page. You can also specify
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the name of the web server and the URL path where your web page will be
located. The wizard then allows you to preview the finished page.

To avoid confusion during the publishing process, two worksheets have been
provided for you below: one for simple HTTP Streaming and the other for
Streaming your media files from a RealServer. It is recommended you complete
the appropriate worksheet before you begin. If you do not have the necessary
information to complete these worksheets, you can obtain it from your Internet
Service Provider (ISP) or your system administrator.

Web Publishing Worksheet for Standard HTTP Web Server

If you are using a standard HTTP web server to stream RealAudio or
RealVideo, you will need to obtain the following information from your system
administrator or ISP.  Please note that for simple HTTP streaming, your web
page and media file will be copied to the same location.

1.  File Server: Name or IP address of the file server that your web page will be
uploaded to.  For example: ftp.server.com. ____________________________

2.  Directory: Name of the directory on the file server where your web page
will be uploaded to. For example, if the personal directory assigned to you by
your system administrator is ‘html’, you would enter html as the directory
name.  _________________________________________________________

3.  Web Server: Name or IP address of the web server that users will use to
locate your web page.  For example, if the full URL users will use to locate your
web page on the Internet is http://www.server.com/html/file.htm:  you would
enter www.server.com as the web server name. ________________________

4.  URL Path: The URL path on the web server that users will use to located
your web page.  For example if the full URL that users will use to locate your
web page on the Internet is http://www.server.com/html/file.htm, you would
enter html as the URL path. ________________________________________
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Web Publishing Worksheet for Streaming from a RealServer

If you are using a RealServer to stream RealAudio or RealVideo, you will need
to obtain the following information from your system administration or ISP.
Please note that for streaming from a RealServer your web page will be copied
to a standard HTTP web server, while your encoded media file may be copied to
a separate RealServer.

1.  File Server: Name or IP address of the file server that your web page will be
uploaded to.  For example: ftp.server.com. ____________________________

2.  Directory: Name of the directory on the file server where your web page
will be uploaded to. For example, if the personal directory assigned to you by
your system administrator is ‘html’, you would enter html as the directory
name.  _________________________________________________________

3.  RealServer: Name or IP address of the RealServer that your encoded
media file will be uploaded to.  For example: ftp.server.com.  _____________

4. Media Directory: Name of the media directory on the RealServer where
your encoded media file will be uploaded to.  For example, if the media
directory assigned to you by your system administrator is ‘media’, you would
enter media as the directory name.  __________________________________

5.  RealServer Location: Name or IP address of the RealServer that users will
use to locate your media file. For example, if the full URL users will use to
locate your media file on the Internet is pnm://pnm.server.com/media/file.rm
you would enter pnm.server.com as the RealServer name.  _______________

4.  URL Path: The URL path on the RealServer that users will use to locate
your media file. For example if the full URL that users will use to locate your
media file is pnm://pnm.server,com/media/file.rm you would enter media as
the URL path.
_____________________________________________________
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To publish a file to stream directly from a standard HTTP web server:

1. Click Publish. The Publish to Server Wizard window appears.

2. Click Next to create a wizard. File Name page appears with the name of
the last web page created using the wizard:

3. Click Next if you wish to publish this page.

4. Click Browse to select another file. Select File page appears. Enter name
of file you wish to publish and click Open.

5. The Streaming Method page appears. Click Stream Media File from a
Standard HTTP Web Server and click Next.

6. The Web Server Information Upload Location page appears. Type in the
name or IP address of the remote  server where you are uploading your
files and the directory on the upload server where your page will be
sent.Then type in your user name and password.

7. The Web Server Information Internet Location page appears. Type in the
name or IP address of the web server and URL path that users will use to
locate your web page on the Internet.

8. Please note that the Upload Location may be different than the one used to
view your web page on the Internet. Contact your Internet service provider
for this information.

9. The Upload Progress page appears. Click Finish. Your files automatically
upload to your web server.

To publish a file to stream directly from a RealServer streaming media server:

1. Click Publish. The Publish to Server Wizard window appears.

2. Click Next to create a wizard. File Name page appears with the name of
the last web page created using the wizard:

3. Click Next if you wish to publish this page.

4. Click Browse to select another file. The Select File page appears. Enter
name of file you wish to publish and click Open.
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5. The Streaming Method page appears. Click Stream Media File from a
RealServer, then click Next.

6. The Web Server Information Upload Location page appears. Type in the
name or IP address of the web serverwhere you are uploading your files
and the directory in the upload server where your page will be sent. Then
type in your user name and password.

7. The RealServer Information Upload Location page appears. Enter the
name or IP address of the RealServer where your media file will be sent.
Enter the directory where your media file will be sent and click Next.

8. The RealServer Information  Internet Location page appears. Type in the
name or IP address of the RealServer and URL path that users will use to
locate your media file on the Internet.

 Please note that the Upload Location may be different than the one used to
view your media file on the Internet. Contact your Internet service provider
for this information.The Upload Progress page appears.

9. Click Finish. Your files automatically upload to your web server.
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Live Broadcasting

With a RealServer streaming media server, you can send live events directly to
user’s computers, letting people enjoy music, speeches, and public events from
their computers. Whether you are promoting a concert, holding a company
meeting, or covering a campaign speech, you can use RealAudio and RealVideo
to attract whole new audiences.

Broadcasting live requires using RealServer steaming media server with a
RealEncoder or RealPublisher for transmission over the Internet. If you choose,
you can save the event to disk while you are broadcasting.

For each encoding algorithm that you want to broadcast live, you need an
Encoder. For example, to offer a live broadcast in both RealAudio 2.0 - 28.8
and RealAudio 3.0 - 28.8 Stereo, you need to run two copies of RealAudio
Encoder sending their output to a RealServer streaming media server. The
bandwidth negotiation feature of the RealServer automatically delivers the
highest bandwidth signal supported by the Player.

Encoder

Format 3

Encoder

Format 2

Encoder

Format 1
Real Server

Live
Source

RealPlayer
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Advertising Your Event

If you want help advertising your site or live event, you can advertise in
“Timecast: Your RealMedia Guide” (http://www.timecast.com), the
RealNetworks online resource for RealAudio and RealVideo sites and live
events.

Inform the Timecast staff of your site or event by completing an online form.
After you submit the online form, the data is verified by a staff member of
Timecast and posted on the Timecast site. Timecast strives to be a quality
listing service and therefore maintains editorial control over all information
submitted. If you have any questions or need to make changes to any
submissions please email Timecast@Timecast.com.

To advertise your site on Timecast:

Use the Web form located at  http://cgi2.timecast.com/cgi-bin/addsite.cgi to
submit your newly completed site for inclusion in either Timecast’s Audio,
Video, or Live Stations Guide. On the Web form, you enter basic information
about the site such as the site name, URL, and description.

To advertise your event on Timecast:

Use the Web form located at http://cgi2.timecast.com/cgi-bin/addlive.cgi to
submit all your live events. On the Web form, you enter basic information about
the event, such as name, complete URL, date and time of the event, and a short
description. You can also indicate whether the event is recurring (occurs
weekly) or non-recurring (one-time only).

Place Special Tags in your HTML Code

If you have several different events, you can save time by inserting special “live
tags” in your HTML code. The live tags are placed within comment lines in the
source html, so that they are invisible to your users. A software robot reads the
information in the live tags and automatically enters the event(s) in Timecast.
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To advertise your live event using special tags:

1. On the web page with the link to your live event, insert the live tags using
the following format:

<!--@Rastart event="Brief Event Description"
start="Thu, 11 Apr 1996 20:30:00 EST" -->
(some HTML that describes the event)
<!--@RAend-->

 Note For more information about the live tag, refer to:
http://www.real.com/help/content/livetags.html

2. Send e-mail to: live_event@prognet.com. Do not enter a subject. In the
body of the e-mail, enter the complete URL for the page containing the live
tags (for example: http://www.real.com/example/tags.html). A software
Robot gathers the information in your live tags. The data is verified by a
staff member of Timecast and posted.

 Note It is VERY important that you include the full address, including
the “http://” part. If you use frames, be sure to send the address for the
event page that appears within a frame, not the HTML page that creates
the frames.
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Delivering Live Content

RealEncoder or RealPublisher included with RealServer streaming media
server can deliver live content for broadcasting live events.

To deliver live content, you need:

• A live source

• A computer running RealEncoder or RealPublisher

• A server running a RealServer

The computer running the encoder and the computer running RealServer can
be on different platforms.

Setting Up RealServer

To enable live delivery, be sure the following configuration settings are
included in the RealServerconfiguration file:

• PnaPort - the port number to which the Encoder connects

• EncoderPassword - the password the Encoder uses to connect

You have the option of specifying that the Server saves the live content as a
RealAudio or RealVideo file by setting the LiveFileTarget and
LiveFilePassword configuration option.

Connecting the Encoder to RealServer

RealEncoder and RealPublisher translates the broadcast into one or more
formats that  RealServer can distribute over the Internet. As administrator of
the RealServer , you must provide a way for the RealEncoder or RealPublisher
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to connect to RealServer. You do this using the PnaPort and
EncoderPassword configuration settings.

The EncoderPassword setting specifies the password the Encoder must use to
connect to RealServer. Passwords are necessary to keep unauthorized users
from connecting to the stream of your live broadcast. For example, if you have
the setting:

EncoderPassword FrogNet

the person starting the Encoder must use the password FrogNet to start the
Encoder.

Bandwidth negotiation during live events is a feature from RealAudio 3.0 that
is no longer supported in RealServer. If you are using RealAudio 3.0, connect
one encoder for each encoding algorithm you want to support. Specify the same
file name as the output from each encoder. RealServer recognizes the format of
each stream and directs it to RealPlayers requesting that format.

The EncoderTimeout configuration parameter specifies how long
RealServerstays connected to an encoder that is not sending data.

EncoderPassword

Password used by RealAudio Encoder, RealEncoder or RealPublisher and the
slta utility program to connect to RealServer.

Used by pnserver

Default value (none)

Range of values Alpha-numeric string without
spaces

Restart Server after change No

EncoderPassword <password>
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Note that the default setting of no password allows any RealAudio Encoder,
RealEncoder, or RealPublisher to connect to the server.

Example

EncoderPassword rmRecord1

EncoderTimeout

The time in seconds that the Server will wait before disconnecting
RealEncoder/RealPublisher that is not sending data. If the connection to
RealEncoder/RealPublisher is lost, the Server must disconnect before
RealEncoder/RealPublisher can reconnect.

Used by pnserver

Default value 30

Range of values 1 - 32767 seconds

Restart Server after change No

EncoderTimeout <seconds>

Setting EncoderTimeout to less than 10 seconds is not recommended.

Example

EncoderTimeout 20
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RealAudio and RealVideo Live Broadcasts

With the appropriate RealServer license key, RealEncoder and RealPublisher
can deliver live content for broadcasting live events.

To deliver live content, you must:

1. Install RealEncoder or RealPublisher on the encoding machine.

2. Install RealServer on the serving machine. (It may be the same as the
encoding machine.)

3. Attach your audio or video source to the audio or video capture card.

Note:  RealEncoder, RealPublisher and RealServercomputers can be on
different platforms.

System Requirements for Live RealVideo

Delivering live video content at a higher frame rate requires a different system
configuration that delivering live content at a low frame rate. Three
recommended configurations are detailed below.
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Configuration 1: Low Frame Rate (<2 frames per second)

Source Feed
Any video
source with
S-video or
composite
output

Encoding Station
• Pentium 166 or

greater
• VFW capture

card
• Windows 95
• Sound card
• RealPublisher or

RealEncoder
• RealServer

RealSystem
Server

Any
RealPublisher
or RealEncoder
supported
platform

S-Video (preferred)
or Composite

Point-to-Point IP Connection
(Internet not recommended)

Internet Connection

Configuration 2: High frame rate (up to 10 frames per second* <200 streams)

Source Feed
Any video source
with S-video or
composite output

Encoding Station and
RealServer

• Dual Pentium 200 Pro
• VFW capture card
• Windows NT
• Sound card
• RealPublisher
• RealServer

S-video (preferred)
or composite Internet Connection

*Actual maximum frame rate is dependent on bit rate and content.

Configuration 3: High frame rate (up to 15 frames per second)

Source Feed
Any video
source with S-
video or
composite
output

Encoding Station
• Dual Pentium 200 Pro
 VFW capture card

with NT drivers
• Windows NT
• Sound Card
• RealPublisher
 or RealEncoder
• RealServer

Real Server
Any RealServer
supported
platform

S-video (preferred)
or composite

Point-to-Point IP connections
(Internet not recommended)

Internet Connection
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Software Requirements

To broadcast live, the following software is required:

• RealEncoder or RealPublisher

• A minimum of a 60 stream RealServer

• RealPlayer

Producing High Quality Live Content

• The average bit rate should be equal to the requested bit rate (the bit rate
specified in the template). If the average bit rate exceeds the requested bit
rate, you can:

1. Switch to optimal frame rate.

2. Use a lower bit rate audio codec.

3. Use a higher requested bit rate.

• Audio quality is important when delivering live content. Setting the
volume too low can result in a weak signal. Setting the volume too high
can cause a distortion of the audio.

• Under no circumstance is loss of audio acceptable. If you experience audio
loss in a live broadcast:

1. Use optimal frame rate to ensure you don’t send data at too high of a
data rate.

2. Test data with similar content before using a set frame rate.

3. Lower the frame rate. If necessary, lower the video quality.

• Latency, the amount of time required for buffering the video, should not
exceed 5-10 seconds when delivering live content.

• View the live content using a RealPlayer. This allows you to see how the
live content looks when it is delivered.

• If you are not maintaining the required frame rate, reduce the system load
by disabling the encoder preview window.
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1. If you are having encoding problems you have five variables to adjust:

2. Frame size

3. Frame rate

4. Bit rate

5. Audio codec (portion of total bits)

6. Quality

You may need to experiment with these variables to achieve the overall
effect you are after.
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Encoding Templates

Live encoding usually requires creating your own template. How you design
your template depends largely on the power of your system. When encoding
video frames that are 176 pixels by 144 pixels, a dual processor 200 MHz
computer gives a good result with a frame rate of 4 fps, Quality 100, or with a
frame rate of 9 fps, Quality 25. A single processor Pentium system gives a
better result when set at 2-3 fps.

For more information about creating templates, refer to the “Using
RealEncoder and RealPublisher.”

Encoding and Broadcasting Live Content for Windows

RealEncoder and RealPublisher for Windows runs on Windows 95 and
Windows NT.

To provide content in multiple compression algorithms, run multiple machines
using RealEncoder or RealPublisher with the same input signal. All
concurrently running copies of RealEncoder or RealPublisher should use
identical settings except for Compression Type and stream name.

To encode and broadcast live audio or video using RealEncoder or RealPublisher:

1. Start RealEncoder or RealPublisher.  The RealEncoder or RealPublisher
window opens.

2. Click Open Session from the File menu. The Open Session window
appears:

3. In the source pane, verify that Capture Device is selected.

4. Click Audio Capture for audio only or select Audio Capture and Video
Capture for video with audio.

5. In the destination pane, click RealServer.

 While performing a live broadcast you can archive the event by also
selecting Destination RealMedia File from the Open Session window.
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6. Enter host name, which is the domain name or the IP address of the
RealServer streaming media server computer.

7. Enter your password. This field is optional depending on how your
RealServeris set up.

8. Enter the resource name, which is the name you give to the audio or video
stream being encoded and which users will refer to.

9. Click OK. The Open Session window closes.

10. In the properties pane, enter the Title, Author, and Copyright information
for your output stream. These fields are optional. If you choose to provide
this information, it will be displayed on the viewer’s Real Player.

11. To allow RealPlayer Plus users to save your  Real Audio or RealVideo
signal to disk, click Selective Record.

12. In the templates pane, select the template to encode the file.

13. Select Statistics from the View menu. The Statistics window appears. The
information displayed in this window during broadcast will help you
evaluate and adjust your template settings.

14. The audio level meter, view input video window and view output window
can be turned off to marginally increase performance. From the Options
menu, click Show Source Input, Show Encoded Output, and Show
Audio Meter  to clear the selection.

15. For video encoding only, notice Frame Rate in the results pane of the
Statistics window. Wait while enough data is collected for an average
frame rate to be determined. If the average frame rate is below the frame
rate set in your template, adjust the encoding by varying one of the five
variables.

16. For video encoding only, notice Latency in the results pane of the
Statistics window. If latency is greater than 5 or 10 seconds, adjust the
template.

17. For video encoding only, select Set Video Format from the Options menu.
You can use this option to adjust video format settings while delivering
live content. Click OK to accept the current settings.
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18. Click Start and monitor the progress of the encoding.

 Listening and viewing the live content through your Web browser is
strongly recommended.

Live Encoding Command-Line Control

Command line options allow automation of live feeds. Refer to the “Command
Line Encoding for Windows”section of the “Editing Video Files” chapter for a
list of static encoding options. Additional RealEncoder/RealPublisher options
for live encoding are listed below:

Option Description

/L Turns on Live Input instead of static input
file. The destination can then be selected
between server or file output.

/S server[:port]/filename Specifies delivery to a server on the
supplied port. If the port is not supplied
then the default of 7070 is used. The server
can be either a hostname or IP address. The
filename is used as the target on the server.

/W password Specifies the password, if required to
connect to the Live Server. The default is
no password and is only used if the target is
a server.

/O Used for the file name at the encoder if
simultaneous file output is required.

/I Specifies an Input File.

/D hhh:mm:ss Allows the encoder to run for the supplied
time. The maximum time is 999:59:59.
When the time elapses then the encoder
should gracefully shutdown and exit. If a
static file is being encoded and the file ends
before the maximum duration, there is no
need for an error message. If this option is
not supplied, then the encoder continues to
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run.

Ctrl-C terminates encoding.

Enhancing Live Broadcasts with Video Image Maps and
Synchronized Web Pages

You can deliver a Synchronized Multimedia presentation or apply an image
map to a video stream with a live broadcast. The events are delivered relative to
the time a client begins playing the live broadcast, instead of relative to an
absolute position in the broadcast.

The URL events must be defined before the broadcast, but you can change the
content of the Web page the URL references during the broadcast.

An image map can change over time, but this is not synchronized with the
video stream. You can add any static content type to a live stream that is not
already present in the stream. An example of this could be a link for the whole
image to a site with a link to the broadcaster tied to a superimposed logo added
to the stream before encoding.

To create a Synchronized Multimedia presentation for a live broadcast:

1. Create the input file that defines each event and the time that the event is
sent. Remember that the times you specify are relative to when the client
begins playing the live broadcast.

2. Run the rmmerge tool to create a .rm file. Repeat steps 1 and 2 for any
image maps.

3. Name the .rm file with the same filename you specify in the Resource box
in RealPublisher or RealEncoder  for the broadcast.

4. Move the .rm file to the path specified in the Resource box in
RealPublisher or RealEncoder .

The file must be named concert.rm and it must be located in the /live directory
relative to the server's base path.
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Simulating a Live Broadcast

At times, you might want to play a recorded media file as if it were being
broadcast live. Perhaps you want to test your system before a live event, delay
broadcast of a concert, or play a commercial on your site. The slta (Simulated
Live Transfer Agent) utility lets you play a recorded media file as if it were live.

To use slta, you need to specify the password from the Server’s
EncoderPassword configuration parameter and the name of the input and
output file.

Simulated Live Broadcast

The rvslta (RealVideo simulated live transfer agent) utility delivers pre-
recorded content as if it were a live event. Users connecting to the link will get
the event “in progress”. It can be used as a test, to delay broadcast of a live
event or to multicast pre-recorded content.  The syntax is as follows:

rvslta -i  path\infile.rm /o outfile.rm -s server [-p
port] [-w password]

where:

infile is the path and file name to the input file.
outfile is the path and file name to the output file.
server is the server name.
port is the server port (port defaults to 7070).
password specifies the password slta uses to connect to the server
(defaults to none).

For example:

rvslta -i c:\livefile.rm -o livenow.rm -s
www.testserver.com
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Configuring Your Web Site

After encoding your RealMedia files, you are ready to attach the files to Web
pages. The following sections explain the construction and use of RealMedia
content on your Web site. When you have your RealSystem server set up, use
this information to showcase audio and video content from your site.

Making the Most of Your Content

To get the most out of your RealMedia content, educate your Web site’s visitors
about RealAudio and RealVideo. Let people know that they can listen and view
your clips instantly, without download delays. Identify each clip with a Real
bubble icon to distinguish it as real-time audio and video.

The graphics are available from the RealNetworks Web site at

www.real.com

Make it easy for your visitors to get RealPlayer by linking the graphics to the
RealNetworks home page at:

www.real.com/
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Metafiles

RealMedia material is reached via links, just as HTML documents use
hyperlinks to connect Web pages. However, the RealMedia links you put into
your HTML pages are not direct references to the RealAudio or RealVideo files.
Instead they are references to metafiles which contain information needed to
establish a connection between your RealSystem server and the user’s
RealPlayer and to initiate playback.

Instead of pointing to a file, your Web page is set up to point to a metafile. This
metafile, in turn, contains the URL (Uniform Resource Locator) of the file (or
files) you want associated with the hyperlink. The user’s browser passes the
URLs to RealPlayer, which retrieves .ra or .rm files from your RealSystem
server.

Metafiles contain the addresses of RealAudio (.ra) and RealVideo (.rm) files.
These addresses are in the form of URLs. The URLs used to establish a direct
connection between a RealPlayer and your RealSystem server begin with
“pnm://” (RealNetworks Metafile). Once in place, this direct connection is
used to stream to the Player and to carry commands (such as seek or pause)
back to your RealSystem server.

Creating Metafiles

Your Web pages will link to metafiles, which in turn point to the DNS name of
the computer on which your RealSystem server and RealMedia files are located.

If you are using Flash Animation, you’ll include that information in the
metafiles.

To create a metafile:

1. Use a text editor (such as Notepad) to create a file containing the
RealAudio or RealVideo URL. The contents of your file should be in the
following form:

pnm://hostname/path

 For example, to provide access to a RealVideo file called hello.rm, the
text of your metafile would be:
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pnm://www.server1.com/hello.rm

 where www.server1.com is the DNS name of the machine running
your RealSystem server, on which you store your RealAudio or RealVideo
files.

 If you want more than one file to play when the user clicks your link,
create a metafile containing several URLs (on separate lines with no
intervening blank lines). For example, if your metafile contains:

pnm://www.server1.com/hello.rm
pnm://www.server1.com/welcome.rm
pnm://www.server1.com/coolstuff.rm

 the Player automatically plays your three files in sequence. A listener can
use the Clip menu on the Player to move forward and backward between
clips.

 If you are using Flash Animation, add file names to the .rm information:

pnm://www.server1.com/hello.rm+hello.swf
pnm://www.server1.com/welcome.rm
pnm://www.server1.com/coolstuff.rm

2. Save your metafile in the “All files (*.*)” format, using a .ram file name
extension.

 For example, you could save the three lines shown above in a file named
3track.ram on your Web server.

3. In your HTML document, reference the metafile in a hyperlink, followed
by a reference to the Real icon (so that the Real icon is displayed to the left
of the file) as follows:

<A HREF="http://www.real.com/welcome.ram"> <IMG
SRC="http://www.real.com/pics/rvfile.gif"
align=left border=0> Welcome!</A>

 where welcome.ram is the metafile.

File Name Extensions

Each metafile that you create must be given a file name extension. This
extension tells your Web server what the metafile is, to ensure that the enclosed
URL is handled properly.
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There are two metafile types:  .ram and .rpm. These different file name
extensions are passed on by your Web server and  tell the user’s Web browser
which application to launch to play the referenced file:

.ram file – Web browser launches RealPlayer

.rpm file – Web browser launches RealPlayer Plug-in (see below)

Note You must configure your Web server to understand that the extension
.ram refers to the MIME type x-pn-realaudio.

Customizing Calls to Video and Audio Content

Optional arguments may be added to metafiles to finesse what is seen and heard
by users when they click your RealMedia link. You may alter the point in a clip
at which play starts or ends, or the Title, Author, and Copyright information is
displayed by RealPlayer.

Add the options to your metafile following the URL to which they apply.
Options must be preceded by a ? (question mark) and separated from each other
by an & (ampersand). The syntax is as follows:

pnm://www.real.com/test.rm?[opt1]&[opt2]

Changing Start and Stop Times

To create a link that starts playing a clip from a point other than the beginning
of the file, use the start command. Specify the time into the clip at which play
should begin. For example:

pnm://www.real.com/test.rm?start="30"

would result in playback starting thirty seconds into the file.

The format for the start time is as follows:

start="dd:hh:mm:ss.ss"

Tenths of seconds are separated from seconds by a decimal point; the other
units of time are separated by colons. The time is interpreted from right to left,
and it is not necessary to specify days, hours, or minutes if these are not
relevant.

Similar to the start option is the end option. For example, the metafile text:
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pnm://www.real.com/test.rm?end="5:30"

is used to provide for playback of test.rm that terminates five minutes and thirty
seconds from the start of the clip.

Note:   The end time is always measured from the actual start of the data in the file, even in
the case where playback begins elsewhere. For example, the line:

pnm://www.real.com/test.rm?start="30"&end="5:30"

is used to start play of test.rm from the thirty-second mark and to stop play five
minutes later.

Changing Title, Author, or Copyright Information

The following options exist to change the descriptive information from within
the metafile:

title="new title"
author="new author"
copyright="new copyright"

Strings can be changed independently or in combination.

Changing information in this manner does not change what is stored in your
file—only what is displayed when it is accessed through this particular
metafile. This functionality is especially useful if, for example, you have one
large file that contains your band’s entire CD, and you want to credit the author
of each song as it plays. You could create a multi-clip .ram file as follows:

pnm://www.server/band.rm?end="5:30"&title="Song1"
pnm://www.server/band.rm?start="5:31"&end="7:45"

&title="song2"&author="Joe Smith"
pnm://www.server/band.rm?start="7:46"&end="15:01"

&title="song3"&author="Jane
Smith"&copyright="My Music, 1996"

HTTP Streaming

HTTP streaming enables content providers to stream RealMedia clips from a
World Wide Web server. While this method is not as robust as using metafiles,
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it provides a reasonable method for providing short RealMedia content to a
limited number of users.

Before you can stream RealAudio and RealVideo clips through HTTP, you
must define the following MIME types for your World Wide Web server:

audio/x-pn-RealAudio (files with a .ra, .rm or
.ram file extension)

audio/x-pn-RealAudio-plugin (files with a .rpm
file extension)

video/x-pn-RealVideo (files with a .ra, .rm or
.ram file extension)

video/x-pn-RealVideo-plugin (files with a .rpm
file extension)

Some World Wide Web servers are pre-configured with these MIME types.

Note:   If you are running a Web page off an ISP server, ask the ISP administrator to
configure the RealPlayer mime type.

To stream RealAudio and RealVideo content using HTTP:

1. Copy your encoded RealAudio and RealVideo files (files with the .ra or .rm
extension) to your World Wide Web server.

2. Use a text editor (such as Notepad) to create a metafile containing the
RealAudio or RealVideo URL. For example, the contents of your file
should be in the following form:

 http://hostname/path

3. where hostname is the name of your World Wide Web server. For example:
www.real.com

4. Save your metafile as “All Files (*.*) using a .ram file name extension.

5. In your HTML document, reference the metafile in a hyperlink. For
example:

 <A HREF="file.ram">
<A HREF="http://hostname/file.ram">

6. You can use relative or complete paths. If you use complete paths, you
must include both the hostname and the complete path. For example:
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 <A
HREF="http://www.real.com/home/welcome.ram">

7. When a user clicks on the link, the audio or video file(s) begin to
download. RealPlayer begins playing after a few seconds; it does not need
to wait for the entire file to be downloaded.

Custom Controls for RealAudio and
RealVideo

RealAudio and RealVideo enables seamless integration of RealPlayer Controls
into your Web page layout. You can place individual interactive components,
such as a play button or image window, anywhere on your page, just as you
would place an image using the <IMG> tag in HTML.

There are two products which, in conjunction with the most popular Web
browsers, enable “in page” audio controls.

• RealPlayer Plug-in provides Player-like features to browsers that support
the Netscape Navigator Plug-in architecture. This plug-in also works in
Internet Explorer 3.0.

• RealPlayer Control for ActiveX works with Internet Explorer 3.0 and
Visual Basic applications to provide RealAudio and RealVideo playback
capabilities.

Using RealPlayer Plug-in

The Plug-in runs as an adjunct to Web browsers that support Netscape’s Plug-
in architecture. This RealPlayer Plug-in is included in the Player installation.

The <EMBED> tag specifies Plug-in attributes in HTML pages in much the
same way that the <IMG> tag specifies image attributes. The basic <EMBED>
tag for RealPlayer contains only the attributes SRC, WIDTH, and HEIGHT, as
shown below:

<EMBED SRC=metafile.rpm WIDTH=width_value
HEIGHT=height_value>
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For example:

<EMBED SRC="sample1.rpm" WIDTH=300 HEIGHT=134>

creates an in-page RealPlayer that is 300 pixels wide and 134 pixels high.

For the Plug-in, metafiles are stored with a .rpm file name extension.

The name tag is supported as an option with JavaScript to refer to a specific
plug-in.

Note Do not place the <EMBED> tag within a table.

Feature Description

SRC Attribute The SRC attribute specifies a metafile to be accessed.
RealPlayer Plug-in is associated with a .rpm file name
extension. This extension tells the user’s Web browser
to load RealPlayer Plug-in rather than the stand-alone
RealPlayer.

For the user’s Web browser to correctly identify .rpm
files, you or your system administrator must first
configure the .rpm MIME type in your Web server.
Users do not need to configure their Web browsers to
recognize the .rpm MIME type. The plug-in
architecture automatically sends .rpm files to RealPlayer
Plug-in. Files with a .rpm extension are identical to
.ram files, except for the extension.
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Feature Description

WIDTH and
HEIGHT
Attributes

The WIDTH and HEIGHT attributes specify the size of
the embedded RealAudio or RealVideo component.
Unlike images, Plug-ins do not size automatically. The
WIDTH and HEIGHT can be specified in pixels (the
default) or as a percentage of the Web browser window
(for example: WIDTH=100%).

Note If the WIDTH and HEIGHT attributes are not
included, the Plug-in may appear as a tiny (and useless)
icon with some browsers.

If you want your Plug-in component to maintain an
absolute size, specify HEIGHT and WIDTH in pixels. If
you want the Plug-in graphic to scale with the Web
browser window, specify size as a percentage. For
example, if you want to fit the entire width of the Web
browser window, use WIDTH=100%.

CONTROLS
Attribute

The CONTROLS attribute of the <EMBED> tag allows
you to place individual control elements within your
page. You can use multiple <EMBED> statements to
construct a custom interface, made up of individual
controls. You can also place multiple controls within a
single <EMBED> statement. CONTROLS supports the
following values: All, ControlPanel, InfoVolumePanel,
InfoPanel, StatusPanel, StatusBar, PlayButton,
StopButton, VolumeSlider, PositionSlider,
PositionField, StatusField, ImageWindow.

CONSOLE Sets a console name used to link multiple control
instances. All controls with the same console name
work together. For example, if you have multiple Play
and Stop buttons on the same page, the console name
would enable them to control the same RealAudio or
RealVideo clip. Call this function once for each
instance of the Play or Stop button you want to link.

The console name. “_master” links to all instances.
“_unique” links to no other instances.
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Feature Description

AUTOSTART Sets whether or not the control automatically starts
playing once the source data is available. Valid values
are TRUE or FALSE.

NOLABELS Suppresses the Title, Author, and Copyright label text
in the controls window. The text strings in the fields are
still displayed.

RESET Resets RealPlayer Control for ActiveX playlist. Valid
values are TRUE or FALSE.

AUTOGOTOURL Specifies how a URL is handled. Valid values are
TRUE or FALSE. TRUE indicates that RealPlayer
Control for ActiveX automatically forwards the URL
event to the browser. FALSE indicates that the
OnGotoURL VBScript event is used instead.

Creating HTML Pages for Browsers Unable to Use the Plug-
in

Some Web browsers do not support plug-ins. You can create HTML pages that
are enhanced for plug-ins but which also work for other browsers. Simply use
the <NOEMBED> tag to include HTML statements for use by Web browsers
that do not support Plug-ins.

The <NOEMBED> command should appear after an <EMBED> command and
take the following syntax:

<NOEMBED> HTML to be ignored </NOEMBED>

For example, the command:

<EMBED SRC="sample1.rpm" WIDTH=300 HEIGHT=134>
<NOEMBED> <A HREF="sample1.ram"> Please play the
clip using the stand-alone RealPlayer!
</A></NOEMBED>

would show a page with the Plug-in if your page were accessed by a browser
supporting Plug-ins, and would otherwise display the message “Please play the
clip using the stand-alone RealPlayer!” (and allow playback with the standard
RealPlayer).
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Using RealPlayer Control for ActiveX

You can embed RealPlayer Control for ActiveX in HTML pages using the
Object tag.

The following is an example of RealPlayer Control <OBJECT> in an HTML
page.

<OBJECT
ID=RAOCX
CLASSID="clsid:CFCDAA03-8BE4-11cf-B84B-0020AFBBCCFA"
HEIGHT=140
WIDTH=312>
<PARAM NAME="SRC" VALUE="pnm://audio.real.com/file.rm">
<PARAM NAME="CONTROLS" VALUE="all">

</OBJECT>

Note Directory names cannot have spaces.

Embedded Object Parameters

Feature Description

OBJECT Tag is used to embed RealPlayer Control for ActiveX.
There should be one <Object> tag per RealPlayer Control
on the page.

CLASSID Specifies the control's CLSID. This value is always
“clsid:CFCDAA03-8BE4-11cf-B84B-0020AFBBCCFA”
for RealPlayer Control for ActiveX.

HEIGHT Specifies the control's height on the HTML page. A value
of  0 makes the control invisible.

WIDTH Specifies the control's width on the HTML page. A value
of  0 makes the control invisible.

PARAM Specially embedded tag for supplying parameters to the
ActiveX object.

The following properties are available to the PARAM Parameter:
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Parameter Description

SRC Sets the source of RealAudio or RealVideo clip. The
SRC location can be pnm, file or http protocol. This
parameter is required.

CONTROLS Sets the visible components of the control. Valid
CONTROLS include All, ControlPanel,
InfoVolumePanel, InfoPanel, StatusPanel, StatusBar,
PlayButton, StopButton, VolumeSlider,
PositionSlider, PositionField, StatusField, and
ImageWindow.

CONSOLE Sets a console name used to link multiple control
instances. All controls with the same console name
work together. For example, if you have multiple Play
and Stop buttons on the same page, the console name
would enable them to control the same RealAudio or
RealVideo clip. Call this function once for each
instance of the Play or Stop button you want to link.

The console name. “_master” links to all instances.
“_unique” links to no other instances.

AUTOSTART Sets whether or not the control automatically starts
playing once the source data is available. Valid
values are TRUE or FALSE.

NOLABELS Suppresses the Title, Author, and Copyright label
text in the controls window. The text strings in the
fields are still displayed.

RESET Resets RealPlayer Control for ActiveX playlist. Valid
values are TRUE or FALSE.

AUTOGOTOURL Specifies how a URL is handled. Valid values are
TRUE or FALSE. TRUE indicates that RealPlayer
Control for ActiveX automatically forwards the URL
event to the browser. FALSE indicates that the
OnGotoURL VBScript event is used instead.
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Specifying How the Control Should Look

The CONTROLS attribute allows you to place individual control elements
within your page. The CONTROLS attributes for the Netscape Navigator Plug-
in and RealPlayer ActiveX Control are the same. The following explains the
output of each attribute:

All - Displays a full Player view including the Control Panel, Information-and-
Volume Panel and Status Bar.

Minimum Width: 21% Maximum Width: 100%
Minimum Height: 23% Maximum Height: 80%

InfoVolumePanel - Displays the Title, Author, and Copyright information
panel and the volume slider.

Minimum Width: 21% Maximum Width: 100%
Minimum Height: 12% Maximum Height: 50%

InfoPanel - Displays the Title, Author, and Copyright information.

Minimum Width: 20% Maximum Width: 100%
Minimum Height: 10% Maximum Height: 50%

ControlPanel - Displays the play/pause button, the stop button and the position
slider.

Minimum Width: 21% Maximum Width: 100%
Minimum Height: 8% Maximum Height: 25%

StatusPanel - Displays the Status Panel showing informational messages,
current time position, and clip length. If you do not embed a Status Panel in
your page, error messages are displayed in the Web browser’s status bar.
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PlayButton - Displays the play/pause button.

Minimum Width: 5% Maximum Width: 100%
Minimum Height: 2% Maximum Height: 25%

StopButton - Displays the stop button.

Minimum Width: 5% Maximum Width: 100%
Minimum Height: 2% Maximum Height: 25%

VolumeSlider - Displays the volume slider.

Minimum Width4% Maximum Width100%
Minimum Height10% Maximum Height100%

PositionSlider - Displays the position slider.

Minimum Width 8% Maximum Width 100%
Minimum Height 5% Maximum Height 25%

PositionField - Displays the field of the Status Bar showing position and clip
length.

Minimum Width: 10% Maximum Width: 100%
Minimum Height: 4% Maximum Height: 25%

StatusField - Displays the message text area of the Status Bar.

Minimum Width: 13% Maximum Width: 100%
Minimum Height: 4% Maximum Height: 15%
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ImageWindow - Displays the video image. (Only available for .rm files)

Minimum Width: 100% Maximum Width: 100%
Minimum Height: 100% Maximum Height: 100%

StatusBar - Displays the status field, position field, channels (stereo/mono).

Minimum Width: 21% Maximum Width: 100%
Minimum Height: 5% Maximum Height: 14%

ActiveX Methods and Properties

Methods

Methods are functions that control the performance of the Control. Unless otherwise noted,
these methods have no return values and no parameters.

Method Description

DoPlayPause Plays or pauses the current clip. Equivalent to clicking the Play/Pause
button.

DoStop Stops the clip. Equivalent to clicking the Stop button.

DoNextItem Skips to the next clip in a .ram file that contains multiple clips. A .ram file
is a metafile that points to one or more RealAudio or RealVideo files.

DoPrevItem Skips to the previous clip in a .ram file that contains multiple clips. A .ram
file is a metafile that points to one or more RealAudio or RealVideo files.

CanPlayPause Tests if Play/Pause function is available. Returns TRUE or FALSE

CanStop Tests if Stop function is available. Returns TRUE or FALSE.

HasNextItem Tests if the next clip function is available. The next clip function is
available when the connected source is a .ram file that contains multiple
clips, and the current clip is not the last clip in the .ram file. Returns true
or false.

HasPrevItem Tests if the previous clip function is available. The previous clip function is
available when the connected source is a .ram file that contains multiple
clips, and the current clip is not the first clip in the .ram file. Returns true
or false.

AboutBox Opens the Copyright information for the control.
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EditPreferences Opens the Preferences dialog box. Enables the end user to set his/her
preferences. These preferences are global to all RealAudio or RealVideo
clients on the machine.

HideShowStatistics Shows or hides the Connection Statistics dialog box.

IsStatisticsVisible Tests if the Connection Statistics dialog box is displayed. Returns true or
false.

DoGotoURL(url,
target)

Causes the control to attempt a navigation to the specified URL in the
specified frame target. The container must support URL browsing.
Parameters: string URL, string target.

Object Properties

The object properties are set within Visual Basic and specify properties about the control.

Property Description

Source Specifies the URL of the clip to play. The Source location can be pnm:,
file: or http: protocol.

Controls Returns/Sets the visible components of the control. Valid CONTROLS
include ALL, ControlPanel, InfoVolumePanel, InfoPanel, StatusBar,
StatusPanel, PlayButton, StopButton, VolumeSlider, PositionSlider,
PositionField, ImageWindow and StatusField.

Console Sets a console name used to link multiple control instances. All controls
with the same console name work together. For example, if you have
multiple Play and Stop buttons on the same page, the console name
would enable them to control the same clip. Call this function once for
each instance of the Play or Stop button you want to link. The console
name master links to all instances while unique links to no other
instances.

Autostart Sets whether or not the control automatically starts playing once the
source data is available. Valid values are TRUE or FALSE.

NoLabels Suppresses the Title, Author, and Copyright label text in the controls
window. The text strings in the fields are still displayed.

AutoGotoURL Specifies how a URL will be handled. Valid values are TRUE or
FALSE. TRUE indicates that the RealPlayer ActiveX Control will
automatically forward the URL event to the browser. FALSE indicates
that the OnGotoURL VBScript event will be sent instead.
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Java and JavaScript Methods
Methods are functions that control the performance of the Java enabled RealPlayer Plug-in.

Method Description

SetSource(String
Source)

Specifies the URL of the RealAudio clip to play. The Source location can be
pnm:, file: or http: protocol.

SetControlsString(String
ControlsString)

Returns/Sets the visible components of the control. Valid CONTROLS
include ALL, ControlPanel, InfoVolumePanel, InfoPanel, StatusBar,
PlayButton, StopButton, VolumeSlider, PositionSlider, PositionField, and
StatusField.

SetConsoleName(String
ConsoleName)

Sets a console name used to link multiple RealVideo Plug-in instances. All Plug-
ins with the same console name work together. For example, if you have multiple
Play and Stop buttons on the same page, the console name would enable them to
control the same clip. Call this function once for each instance of the Play or Stop
button you want to link. The console name master links to all instances while
unique links to no other instances.

SetAutoStart(Boolean
bAutoStart)

Sets whether or not the Plug-in automatically starts playing once the source
data is available. Valid values are TRUE or FALSE.

SetNoLabels(Boolean
bNoLabels)

Suppresses the Title, Author, and Copyright label text in the Plug-in window.
The text strings in the fields are still displayed.

DoPlayPause() Plays or pauses the current clip. Equivalent to clicking the Play/Pause button.

DoStop() Stops the RealAudio clip. Equivalent to clicking the Stop button.

DoNextItem() Skips to the next clip in a .ram file that contains multiple clips. A .ram file is
a metafile that points to one or more RealAudio files.

DoPrevItem() Skips to the previous clip in a .ram file that contains multiple clips. A .ram
file is a metafile that points to one or more RealVideo files.

CanPlayPause() Tests if Play/Pause function is available. Returns TRUE or FALSE

CanStop() Tests if Stop function is available. Returns TRUE or FALSE.

HasNextItem() Tests if the next clip function is available. The next clip function is available
when the connected source is a .ram file that contains multiple clips, and the
current clip is not the last clip in the .ram file. Returns true or false.

HasPrevItem() Tests if the previous clip function is available. The previous clip function is
available when the connected source is a .ram file that contains multiple clips, and
the current clip is not the first clip in the .ram file. Returns true or false.

AboutBox() Opens the Copyright information for the control.

EditPreferences() Opens the Preferences dialog box. Enables the end user to set his/her
preferences. These preferences are global to all clients on the machine.

HideShowStatistics() Shows or hides the Connection Statistics dialog box.

IsStatisticsVisible() Tests if the Connection Statistics dialog box is displayed. Returns true or false.
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CallBack Methods

CallBack methods are functions that provide notification from the RealAudio or RealVideo
engine. CallBack methods can only be used with Java applets by implementing the
RAObserver interface.

Method Description
onClipOpened(String
shortClipname, String
URL)

Sent when a clip has been opened.

onClipClosed() Sent to indicate that no clip is currently open.

onShowStatus(String
status)

Sent to indicate that the status text is changing.

setAutoGoToURL(boolean
bAutoGoToURL)

Specifies how a URL will be handled. Valid values are true or
false. True indicates that the RealPlayer Plug-in will
automatically forward the URL event to the browser. False
indicates that the OnGoToURL event will be handled by the
Java applet instead.

onGoToURL(String url,
String target)

Sent when a URL event has been encountered for the
currently playing clip. This event will only occur if the
AutoGotoURL property is false.
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Advanced Control Attributes

The more exciting features of RealPlayer Plug-in and RealPlayer Control for
ActiveX can be enabled by specifying custom attributes within your HTML
documents.

Removing Text Labels from Controls

If your Web page is in a language other than English, or if you want to use the
Description fields to display information other than Title, Author, and
Copyright, you may remove the Title, Author, and Copyright Labels from the
information area. Controls that display Title, Author, and Copyright
information for a clip, support a NOLABELS=TRUE attribute.

For example, allowing the default behavior

<EMBED SRC="use_lbl.rpm" WIDTH=350 HEIGHT=80
CONTROLS=InfoPanel>

or specifying NOLABELS=FALSE

<EMBED SRC="use_lbl.rpm" WIDTH=350 HEIGHT=80
CONTROLS=InfoPanel NOLABELS=FALSE>

results in the following display.

On the other hand, using NOLABELS=TRUE, for example:

<EMBED SRC="no_lbl.rpm" WIDTH=350 HEIGHT=80
CONTROLS=InfoPanel NOLABELS=TRUE>

produces the following InfoPanel:

Starting Clips Automatically

Adding an AUTOSTART=TRUE attribute tells the user’s browser to
automatically begin playing your clip when the page is visited. You can use this
feature to begin narration, to play a welcome message or start a video.

Since only one clip can play at a time, if you specify AUTOSTART for more
than one control instance, only the last control to load will play. The order in
which your files are delivered is dependent on the Web server and on the
browser’s cache size. This is not necessarily the order in which you put them
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within your HTML. Therefore, you should specify AUTOSTART for only one
control instance per page.

Playing Clips with a Hidden Control or Plug-in

If you want to play RealAudio or RealVideo clips without having a visible Plug-
in control, you hide the control. By embedding a Plug-in in your page that has
its size set to width=2 height=0, no image appears on your Web page. You can
control the Plug-in with JavaScript.

For example:

<script Language=JavaScript>
function playSource()
{if (navigator.appName == "Netscape")

{document.javaPlug1.DoPlayPause();}
else

{RAOCX.DoPlayPause();}
}
</script>
<A HREF="#" onClick="playSource()"><IMG

RC="button.gif"></A>
<OBJECT ID=RAOCX CLASSID="clsid:CFCDAA03-8BE4-11cf-B84B-

0020AFBBCCFA" WIDTH=2 HEIGHT=0>
<PARAM NAME="SRC" VALUE="pnm://audio.real.com/welcome.rm">
<PARAM NAME="CONTROLS" VALUE="PlayButton">
<embed src="start.rpm" Width=2 Height=0

Controls=PlayButton name=javaPlug1>
</OBJECT>

The above example works in both Netscape and Internet Explorer. Only one
control will appear on the Web page.

Making Controls Work Together

You can embed any number of RealPlayer controls within a Web page.
Normally, each tag instance refers to different content. Sometimes, however,
you may want to link two or more controls together. For example, you can
create a play button and an image window that work as a pair.

To include multiple components that work together, specify a CONSOLE
attribute for each control and assign this the same value in each instance. For
example:

<EMBED SRC="sample1.rpm" WIDTH=30 HEIGHT=33
CONTROLS="PlayButton" CONSOLE="Clip1">
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<EMBED SRC="empty1.rpm" WIDTH=176 HEIGHT=144
CONTROLS="ImageWindow" CONSOLE="Clip1">

Note Each <EMBED> tag must have a unique SRC attribute (if the same
source is specified for two tags, one is ignored). Create a dummy .rpm file
(named, for example: empty1.rpm) for a second control accessing a clip. Put a
hard carriage return (ASCII code 13) into the dummy file.

Specifying a CONSOLE value of “_master” links a particular control to all other
RealPlayer Controls on the page. Use this value, for example, to add a Status
Bar to display information for all clips, for example:

<EMBED SRC="sample1.rpm" WIDTH=300 HEIGHT=33
CONTROLS="StatusBar" CONSOLE="_master">

Because many platforms, including Windows, only support one volume setting,
all volume sliders act on the same underlying value and affect all clips
regardless of CONSOLE name. For this reason, you may want to include only
one volume slider per page, with no reference to a .rm file in its associated .rpm
file.

If you only include an ImageWindow control on the Web page, the video
stream may still be controlled by using the context sensitive pop-up menu. For
Windows users, right-click the ImageWindow; Macintosh users, click and hold
the mouse button until the pop-up menu appears.

Frame Document

A frame document describes the sub-HTML documents or frames that make up
a window. The basic structure of a frame document is similar to that of a
normal HTML document except that the FRAMESET tag replaces the BODY
tag. Each frame is defined by the FRAME tag. In order to effectively use
RealVideo, each FRAME tag needs the SRC and NAME attributes. The SRC
points to the URL to be displayed in the frame. The NAME attribute assigns a
name to the frame so that it can be targeted by links in other documents. The
example below shows a simple frame document that would create two frames:

<HTML>
<FRAMESET ROWS="105,*">

<FRAME SRC="banner.html" NAME="banner">
<FRAME SRC="lyrics.html" NAME="Lyric">

</FRAMESET>
</HTML>
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Synchronizing Frames and Video and Audio

Frames and RealVideo and RealAudio content are synchronized in the same
way that a regular Web page and RealVideo and RealAudio content are
synchronized: a .rae file. The difference lies in the addition of the targeted
frame name to the text file that is used to create the .rae file. The syntax for
each entry should follow the format:

u starttime endtime &&framename&&EventURL

where:

u stands for URL event (each line starts with the letter u)
starttime is the time into the clip when the new event is shown
endtime is the time into the clip when that event ends, && is a delimiter
framename is the frame name as specified in your frame document
EventURL (generally beginning with "http:" or "file:") is the URL for that
event (usually an HTML document).

The time format is:

[[[days:]hours:]minutes:]seconds[.tenths]

The lines of the input file must be in ascending order of start time. The end
time should be at least one tenth of a second before the start time for the next
event.

The example below shows an .rae input file for a Web site that displays lyrics
as a song plays. Each verse is displayed within a frame called Lyric.

u 00:00:10.0 00:00:35.0
&&Lyric&&http://www.songs.com/ver1.html
u 00:00:35.0 00:00:50.0
&&Lyric&&http://www.songs.com/ver2.html

Note You cannot use frames within a presentation using RealPlayer. You can
only use frames within a multimedia presentation using the Plug-in or ActiveX.

More Information on Frames

A complete discussion of frames is beyond the scope of this manual. For more
information on frame attributes and syntax and on targeting windows consult
the following Web pages:
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Frames -- Syntax

www.netscape.com/assist/net_sites/frame_syntax.html

Targeting Windows

www.netscape.com/eng/mozilla/2.0/relnotes/demo/target.html
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Synchronized Multimedia

In addition to basic audio and video content, RealAudio and RealVideo System
allows you to create real-time on-demand multimedia presentations using the
RMMerge tool (Windows or UNIX). These presentations can be as simple as a
narrated slide show of your home page or as intricate as a multi-frame training
program that the viewer controls.

RealAudio and RealVideo System includes the ability to synchronize World
Wide Web pages with audio. Thus the audio can be used as a “time line” to
display new pages or frames in the Web browser or to update its content. This
enables the creation of Internet slide shows, presentations, guided tours and site
walk-throughs. A user can have full random access (fast forward and rewind),
and the Web browser content is synchronized with the audio.

RealAudio and RealVideo System stores the information for the synchronized
events in a file with a .rm file extension. RealSystem server streams audio and
event information to RealPlayer. The event information is streamed to
RealPlayer, and in turn RealPlayer sends Web page information to the Web
browser telling it to update the page’s content.

Another way to create a synchronized multi-media presentation is using
RealPlayer Plug-in. However, since sending the Web browser to a new URL
unloads RealPlayer Plug-in when the HTML page is unloaded, it is best to
create separate frames for RealPlayer Controls and for the changing images.
For more information about frames, refer to the “Frames: The Basics” section
of the “Synchronized Multimedia” chapter.

Creating a RealVideo Events File

Creating a synchronized multimedia event using .rm files use the RMMerge
tool. This is a three-step process:

1. Use a text editor to create an input file specifying the display time for each
URL, title, author or copyright event.
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2. Use the RMMerge tool to generate a binary file from the text input file by
typing the following command:

 rmmerge -f rmevents.dll event.txt output.rm

 where:

event is the text file created in step 1
output is the .rm file that contains these events

3. Merge your new events .rm file with an audio or video file using the
following command:

rmmerge <event file> <audio or video file> <output
file>

 where:

 event file is the .rm file created in the previous step
 audio/video is the file merged with the event file
 output file is the file resulting from the merge

For example:

rmmerge event.rm audio_video.rm output.rm

Creating the Input File

Begin by creating a list of the URLs, titles, authors, or copyrights that you want
to be shown during your presentation and the times within RealAudio or
RealVideo clip when they should be displayed. The syntax for each entry
should follow the format (with a space between each part of the command):

u starttime endtime EventURL
i starttime endtime Title
a starttime endtime Author
c starttime endtime Copyright

where:

u stands for URL event; each line starts with the letter u
i stands for title; each line starts with the letter i
a stands for author; each line starts with the letter a
c stands for copyright; each line starts with the letter c
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starttime is the time into the clip when the new event is shown
endtime is the time into the clip when that event ends
EventURL (generally beginning with “http:” or “file:”) is the Internet
address for that event (usually an HTML document)

The time for starttime and endtime is:

[[[days:]hours:]minutes:]seconds[.tenths]

The lines of the input file must be in ascending order of start time. The end
time should be at least one tenth of a second before the start time of the next
event. The following example shows how an input file might look:

u 00:00:10.0 00:00:59.9 http://www.real.com/
u 00:01:00.0 00:02:00.0 http://www.mysite.com/ page2/

This input file tells RealPlayer to send the Web browser to the RealNetworks
home page ten seconds into the audio clip. One minute into the audio clip, the
Web browser displays a page from "www.mysite.com".

The input file may also contain comment lines beginning with the # symbol.
These comment lines are ignored by the event creation tool and are a good way
to document the date that the file was created and the type of information found
on each page.

Creating a RealAudio Events File

The RealAudio system allows you to create real-time on-demand multimedia
presentations using the Cevents utility (Windows or UNIX). Creating a
synchronized multimedia event using the Cevents command line tool is a three-
step process:

1. Use a text editor to create an input file specifying the display time for each
URL.

2. Use the Cevents command line tool to generate a binary file from the text
input file.

3. Place the resulting .rae file in the same directory as the .ra audio file.
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Creating the Input File

Begin by creating a list of the URLs that you want to be shown during your
presentation and the times within the RealAudio clip when they should be
displayed. The syntax for each entry should follow the format (with a space
between each part of the command):

u starttime endtime EventURL

where:

u stands for URL event; each line starts with the letter u
starttime is the time into the audio clip when the new event is shown
endtime is the time into the audio clip when that event ends
EventURL (generally beginning with “http:” or “file:”) is the Internet
address for that event (usually an HTML document)

The time for starttime and endtime is:

[[[days:]hours:]minutes:]seconds[.tenths]

The lines of the input file must be in ascending order of start time. The end
time should be at least one tenth of a second before the start time of the next
event. The following example shows how an input file might look:

u 00:00:10.0 00:00:59.9 http://www.real.com/
u 00:01:00.0 00:02:00.0 http://www.mysite.com/
page2/

This input file tells RealPlayer to send the Web browser to the RealNetworks
home page ten seconds into the clip. One minute into the clip, the Web browser
displays a page from "www.mysite.com".

The input file may also contain comment lines beginning with the # symbol.
These comment lines are ignored by the event creation tool and are a good way
to document the date that the file was created and the type of information found
on each page.

Generating an Event File

After creating the text version of the input file, you must convert the file to a
binary event file. This is done with the command line utility Cevents. It uses
the following syntax:
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cevents <input text file> <output event file>

where:

<input event file> is the file you just created
<output event file> is the same name as the file with which it will
be associated.

For example, to a create synchronized multimedia presentation to accompany
paradise.ra, you would generate paradise.rae using the following command:

cevents paradise.txt paradise.rae

Placing Event Files on Your Server

Copy the .rae file to the same directory as your .ra file. The .ra and .rae files
must have the same name except for the file extension. RealSystem server
automatically detects the file and send the event information to RealPlayer,
which then sends it the Web browser.

Using Synchronized Multimedia from Local Files

RealPlayer can also read local .rae files just as the Server does. In order for the
local presentation to work with multiple platforms and with both Internet
Explorer and Netscape Navigator, without hardcoding the directory structure,
you need to follow these steps.

To play a .rae file locally:

1. Place all .rpm/.ram, .ra, HTML and image files in one directory. The
starting document should be named Index.html.

2. Do not use /’s in your file names. Use the following syntax:

u 10.0 45.0 &&media&&test2.html

 Note You cannot use relative path commands like ../ if you want the
presentation work on a Macintosh.

.TXT file - convert into .rae file using Cevents compiler

u 10.0 45.0 &&media&&test2.html
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.RAM and .RPM

file:1shapfut.ra

IMAGES

<IMG src="1shapfut.gif">

HREFs

<a href="rasld011.htm">

EMBEDs

<EMBED SRC="lecture5.rpm">

Using Synchronized Multimedia with
Bandwidth Negotiation

When you deliver a Synchronized Multimedia presentation using Bandwidth
Negotiation, you can choose to deliver the same event for all encoding formats,
or you can choose to deliver different events for each encoding format.

You can create a single synchronized multimedia presentation for multiple
formats, or you can create a different multimedia presentation for each
encoding format. If you are working with previously created content, you can
continue to use the previous method to create presentations. For new content,
refer to the “Synchronized Multimedia” chapter.

Frames: The Basics

Some Web browsers support a feature which allows the browser window to be
divided into multiple regions. Each region is called a frame and can display a
separate URL such as a graphic or document. For an introduction to frames
visit Netscape’s Web site at:

www.netscape.com

If you are unfamiliar with frames the following two sites provide a good
introduction:
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Understanding Frames

www.netscape.com/navigate/understanding_frames.html

Frames: An Introduction

www.netscape.com/assist/net_sites/frames.html
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RealAudio and RealVideo
Content Creation for Internet
Appliances and Set-top Boxes

Recently, there has been a significant increase in the number of appliances such
as televisions, Internet phones etc. that are able to view content resident on
servers on the World Wide Web. Increasingly, these appliances will also have
the capability to view and play RealAudio and RealVideo content. While these
devices may be able to play RealAudio or RealVideo, they are often constrained
in various ways. Some examples of these constraints include:

• Their Internet connections are at relatively low bit rates.

• They may not have the capability to playback RealVideo.

• They may be able to playback content that uses only the
RealVideo(Standard) codec.

To make your content accessible by this increasingly large user population, we
strongly recommend creating content in a variety of formats that are playable
both on RealAudio and RealVideo players running on PCs and workstations as
well as appliances. To do so, you can take advantage of RealAudio and
RealVideo's many codec offerings and do one or more of the following:

• If you choose to use the RealVideo(Fractal) codec to create high-quality,
high bandwidth content, you may also wish to use the RealVideo(Standard)
codec to create a lower bit-rate version of the same content. The same
strategy could be used if you are creating high bandwidth content using
RealVideo(Standard).

• Create links on your web-pages to audio-only versions of video
presentations. These audio-only versions can be created at multiples
bandwidths (using bandwidth negotiation). You may also wish to create
content using codecs that are part of RealAudio Encoder 3.0 to
accommodate users that may have audio players.

Another alternative would be to use bandwidth negotiation and create high
bandwidth RealVideo content and low bandwidth RealAudio versions of the
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same content, ie.  pnrv.20 and 14_4.18 would play video to RealPlayers 4.0 and
5.0 and 14.4 audio to any other.

These options are well supported in RealEncoder and RealPublisher . As time
progresses, making these options available on your site will only add to your
audience.
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Index

A
ActiveX

advanced control attributes, 132
making controls work together, 133
methods and properties, 127
RealVideo Control, 123

Adobe Premiere, 44
encoding, 35
marker options, 37

Advanced Control Attributes, 132
AREA tag, 74
Audio

algorithms, 51
Author. See File Descriptions

B
Bandwidth Negotiation, 43, 78

delivering content, 78
diagram, 79
example, 89
using during live broadcasts, 102
with Synchronized Multimedia, 58, 142

Broadcast. See Live broadcast
Broadcasting, live, 16

C
Cevents, 140
Clips starting automatically, 132
Configuration settings

EncoderPassword, 102
EncoderTimeout, 103

Configuring Your Web Site, 113
Control Attributes, advanced, 132
Controls

autostart, 132
display, 125

no text labels, 132
Conventions used in manual, 8
Copying RealVideo Files

UNIX, 66
Windows, 66

Copyright. See File Descriptions
Custom Controls for RealVideo, 119
Customizing Calls to Audio Content, 116
Customizing Calls to Video and Audio

Content, 116

D
Delivering a RealAudio or RealVideoVideo

Clip, 12
Delivering Live RealVideo Content, 104
Delivering Synchronized Multimedia, 14
Drag-and-Drop Encoding

Windows Encoder, 46
DURATION tag, 73

E
Editing Input Files, 59
Editing RealVideo Files

UNIX, 64
Windows, 59

Editing utilities, 10
Embedded Object Parameters, 123
EncoderPassword setting, 102
EncoderTimeout setting, 103
Encoding a RealVideo clip, 27
Encoding RealVideo files

Adobe Premiere, 44
Events File, creating, 55, 58, 137

F
Filename Extensions, 116
Files
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.ram, 11, 77

.rm, 11

.rpm, 11
delivering with Bandwidth Negotiation, 78
descriptions, modifying, 77
formats, 82, 88
RealServer, 78

Formats, video, 34
Frames, 58, 142

frame document, 134
synchronizing with audio, 135

H
Hidden Controls, 133
HTTP Streaming, 118

I
Image

cropping, 32
quality, 33

Image Map, 73
merging with video image, 76

Input File, creating, 56, 138
Invisible Controls, 133

J
Java and JavaScript

callback methods, 131
methods, 130

L
Live

broadcasting, 16
encoding, 16

Live broadcast
connecting to RealAudio Encoder, 102
example, 98

Live RealEncoder
Windows, 108

Live RealVideo Content, 104
command line controls, 110
high quality, 106

software requirements, 106
system requirements, 104
templates, 108

M
Managing Content, 78
MAP tag, 74

/MAP tag, 76
Metafiles, 11, 114

table of, 80
Modifying RealVideo File Descriptions, 77

P
Plug-in

Adobe Premiere, 44
RealVideo, 11, 119

Producing High Quality Video, 33

R
ram file, 11, 77
Real Icon, 113
RealAudio Encoder

connecting to RealServer, 102
RealEncoder, 10
RealMedia clip, 11
RealPlayer, 10
RealServer, 10

managing content, 78
setting up for live broadcasts, 101

RealVideo clip, 9
encoding, 27
updating, 15

RealVideo Control for ActiveX, 123
RealVideo Live

software requirements, 106
system requirements, 104

RealVideo Live Encoder
Windows, 108

RealVideo Plug-in, 11, 119
RealVideo Tools, 10
rm files, 11
RMCut, 66
RMDump, 67
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RMEdit, 64, 77
RMMerge, 55, 76, 137
RMTools, 77

editing file data, 62
editing file properties, 60
examining file contents, 61

rpm file, 11

S
Settings File

example, 49
Simulated Live Broadcast, 112
Slta, 112

using, 112
Source Files, 28
Synchronized Multimedia, 55, 137

Cevents, 140
frames, 58, 142
from local files, 141
placing on a Server, 141
using with Bandwidth Negotiation, 58, 142

Synchronized Multimedia, delivering, 14

T
Templates, 40, 50

create new, 53
live RealVideo content, 108

Title. See File Descriptions

U
UNIX

copying files, 66
editing files, 64
RMCut, 66
RMDump, 67
RMEdit, 64

V
Video Formats, 34
Video Quality, 33

W
Web Browser, 10
Web Server, 10
Web Site Configuration, 113
Windows

copying files, 66
drag-and-drop encoding, 46
editing files, 64
editing RealVideo files, 59
RMCut, 66
RMEdit, 64

Windows Encoding
command line encoder example settings

file, 49


